6-8

o

Tquchpad:

Computer Series S

Teacher's Manual
&&l‘end’eclgwppad/m Teacherd

including

Lesson Plans, Answer Keys & Practice Worksheets

( This manual belongs to

/\
\
LV Y 1 1=
SCROOI NAM@ ..ottt
L F= LIV [ LK
\Mobile 1 o T )

@NGE””

www.thetouchpad.com




Published by:
Orange Education Pvt Ltd

9, Daryaganj, Near LIC Office
New Delhi-110002
Phone: 43776600 + 50 Lines

8588814859

Email: info@orangeeducation.in

IE Code: 0511063121
First Edition

Branches:

e Ahmedabad ¢ Bengaluru ¢ Chennai

e Dehradun ¢ Guwahati ¢ Hyderabad

e Jaipur e Kochi ¢ Kolkata e Lucknow
e Mumbai ¢ Ranchi

Copyright © Publishers
No part of this publication may be reproduced, distributed, or transmitted in any form or by any means,
including photocopying, recording, or other electronic or mechanical methods, without the prior written
permission of the publisher. Although every safety measure has been taken to verify the precision of the
information contained herein, the author(s) and publisher assume no responsibility for any error or omission.
No liability is assumed for damages that may result from the use of information contained within.



Kepinies

Kepii4

Kepsiny |

Kepsaupap

Kepsan|

Kepuo

IIIA IIA IN A Al III II

sAeq
spoudd

d|gel awli] s,49ydea]



CONTENTS

Development Milestones in @ CRIld...........eorensensionensensisssssessssssssssssssssssens 5-6
Online SUPPOIt .....eeeveerrrrenns ettt s e banees .6
TeACNING PEAAGOGIES ....u.cuvvverrrsrrressissississsisssssissssssssssssssssssssssssssssssssssssssssssssssssses 7-8

e Lesson Plans
e Teaching Strategies
e Bloom'’s Taxonomy

Touchpad-6 9-54
- Lesson Plan ceeerser ettt asesesens 9-22
90 ANSWET KBY .cereiitttisenininentiessssesssesssasssssissessssssssssssssssssssssssasssssessssas 23-45
oo Practice Worksheet .......ovrecnrenneeonnenseesneennnns 46-54

Touchpad-7 55-98
- Lesson Plan ettt b assenas 55-68
90 ANSWET KBY ..cereeririrrieineinsensiessesssesesssssesssssssssessssssssasssssssssssssssssssssssssssssssssssns 69-89
oo Practice Worksheet .......oeoneenneenneeneceneceeenns 90-98

Touchpad-8 99-146
90 LESSON PlAN ettt eiss s sssssissesssesssessssssssesasesanss 99-112
oo Answer Key e ns 113-135
©0 Practice WOrKSh@ert ...t siseissesssessssesssesasesanse 136-145

GO SEttING fOr MY LEAINEIS ....ueeeeeeersrersrensisssesssisssssssssssssssssssssssssssssssssssssssssenns 146-147

Capture your Moments........... 148

e Happy Classroom Moments
e Challenging Classroom Moments
Cyber-Crime Cells iN INAIQ .......vveversvneissrinseseisssssissssssssssssssssssssssssssssssssssssssssssens 149-151

g,
® 4 b

&



Development Milestones in a Child

Development milestones are a set of functional skills or age-specific tasks that most children can do
at a certain age. These milestones help the teacher to identify and understand how children differ
in different age groups.

Age 5 - 8 Years

+ First permanent tooth erupts

« Shows mature throwing and catching patterns

« Writing is now smaller and more readable

« Drawings are now more detailed, organised and have a sense of depth

Physical

« Attention continues to improve, becomes more selective and adaptable
 Recall, scripted memory, and auto-biographical memory improves

« Countsonand counts down, engaging in simple addition and subtraction
« Thoughts are now more logical

Cognitive

« Vocabulary reaches about 10,000 words

L
anguage « Vocabulary increases rapidly throughout middle childhood

« Ability to predict and interpret emotional reactions of others enhances
+ Relies more on language to express empathy

+ Self-conscious emotions of pride and guilt are governed by personal
Emotional/Social responsibility

 Attends to facial and situational cues in interpreting another’s feelings

« Peer interaction is now more prosocial, and physical aggression
declines

Age 9 - 11 Years

Physical + Motor skills develop resulting enhanced reflexes

+ Applies several memory strategies at once

Cognitive .\ LT .
9 « Cognitive self-regulation is now improved

« Ability to use complex grammatical constructions enhances

Language . . .
« Conversational strategies are now more refined

« Self-esteem tends to rise

Emotional/Social
 Peer groups emerge

“If you cannot do great things, do small things in a great way.”



Age 11 - 20 Years

- If a girl, reaches peak of growth spurt
- If a girl, motor performance gradually increases and then levels off

Physical
y « If a boy, reaches peak and then completes growth spurt
« If a boy, motor performance increases dramatically
..  Is now more self-conscious and self-focused
Cognitive

« Becomes a better everyday planner and decision maker

« May show increased gender stereotyping of attitudes and behaviour
Emotional/Social y 9 ypIng

« May have a conventional moral orientation

Managing the children’s learning needs according to their developmental milestones is the key to
a successful teaching-learning transaction in the classroom.

Steps to use “Touchpad Web Support’:

1. Visit our website www.thetouchpad.com

2. Click on Web Support tab.

3. Register yourself and wait for the approval or call 011-43776600.

4. Enter your Login details once received on your e-mail id after approval.
5. Download the material needed.

Software download links:

e Scratch 2.0: https://scratch.mit.edu/download/scratch2
¢ Tux Paint and Tux Paint Stamps: http://www.tuxpaint.org/download/windows/

e MSW Logo: http://www.softronix.com/logo.html

e Python 3.6.5: https://www.python.org/downloads/release/python-365

Technical Support:
e For any technical support call 011-43776600 between 10:00 AM to 06:00 PM.

“Family is the most important thing in the world”
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Teaching Pedagogies

Pedagogy is often described as the approach to teaching. It is the study of teaching methods
including the aims of education and the ways in which such goals can be achieved.

(Lesson Plans

A lesson plan is the instructor’s road map which specifies what students needs to learn and how
it can be done effectively during the class time. A lesson plan helps teachers in the classroom by
providing a detailed outline to follow in each class.

A lesson plan addresses and integrates three key components:
» Learning objectives

* Learning activities

» Assessment to check the student’s understanding

A lesson plan provides an outline of the teaching goals:

/ Before the class: \

1. Identify the learning objectives.

2. Plan the lesson in an engaging and meaningful manner.
3. Plan to assess student’s understanding.

4. Plan for a lesson closure.

N /

During the class:
Present the lesson plan.

After the class:

Reflect on what worked well and why. If needed, revise the lesson
plan.

“Knowing yourself is the beginning of all wisdom.”



(Teaching Strategies

Numerous strategies have evolved over the years to facilitate the teaching-learning process in the

classrooms.
Direct
Instruction

Effective
Teaching
Strategies

Classroom

Discussion

Small
Group Work

Cooperative
Learning

Performance

Activities

Student
Research

Problem
Solving

(Bloom’s Taxonomy

Bloom’s Taxonomy was created by Dr Benjamin Bloom and several of his colleagues, to promote
higher forms of thinking in education instead of rote learning. There are three domains of learning:
cognitive (mental), affective (emotional), and psychomotor (physical). However, when we refer to
Bloom’s Taxonomy we speak of the cognitive domain. Bloom'’s Taxonomy is a list of cognitive skills
that is used by teachers to determine the level of thinking their students have achieved. As a teacher,
one should attempt to move students up the taxonomy as they progress in their knowledge.

Produce & - _ _ _
something new Level 6~
_ . Creating
Take apart information to Level 5
show relationships, causes < - -~ _ Evaluati
- ~ valuating
and connections Level 4
\
Analysing S ., Justify a stand
Level 3 or position
Explain ideas  _ _ .
or concepts PR Applying _
Level 2, RSN
T ’ 4
Understanding =~ -7 Use information in
Level 1 new situations, to
--- answer questions or

Remembering ~ X
Recall facts and
basic concepts

Teachers should focus on helping students to remember information before expecting them to understand
it, helping them understand it before expecting them to apply it to a new situation, and so on.

solve problems

“If you have no confidence in self, you are twice defeated in the race of life”
g
e38)
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LESSON PLAN

1., Computer/Software

Teaching Objectives
Students will learn about
& Software

& Types of Software

Teaching Plan Number of periods: 3

While teaching this chapter, tell the students that a computer is an electronic device that performs
diverse operations with the help of instructions to process the data in order to achieve desired results.

Tell the students that a computer system is made up of hardware (physical components) and software
(set of instructions that make the computer perform tasks).

Make them understand the different types of software as System Software (comprising of Operating
System, Programming Software and Utility Software) and Application Software (comprising of General
Purpose Software and Customised Software).

Tell the students about different types of General Purpose Software like word processors, spreadsheets,
presentation software, DBMS, DTP software, image processing software and multimedia processors
(refer Suggested Activity also).

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

Ask the students some oral questions based on this chapter.

Q. What is a computer?
Q. What is software?
Q. What are the different types of software?
Q. How is system software different from application software?
Q. What is the benefit of using customized software?
Q. Give examples each of:
m  Utility software m  Operating system
m  Word processor m  Spreadsheets
m  Presentation software m  DTP software
m DBMS, etc.

|
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Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 12 and
13 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Page 13. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 14 will enhance the ability of the
students and serve as a Subject Enrichment activity.
Suggested Activity

Ask the students to collect pictures of interfaces of various types of application software and paste
them on a chart paper in a hierarchical chart as shown on Page 9 of the course book.

2. 'Windows)7

Teaching Objectives
Students will learn about

& Windows 7 features & Control Panel

@ Date and Time settings @ Taskbar and Start Menu settings

& Mouse settings @ Sound settings

@ Components of an open window @ Disk Cleanup

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that Windows 7 is an operating system.

Tell the students about some unique and new features introduced in Windows 7 — Sneak, Aero Flip,
Shake, Snap and Jump Lists (refer Suggested Activity also).

Explain to the students about the usefulness and settings provided in Control Panel for covering
e System and Security e Hardware and Sound e Programs

e Appearance e Clock, Language and Region

Demonstrate to the students the steps needed to change date and time of the computer system.
Explain the meanings and use of Taskbar, Notification Area and Start Menu.

Show the students about various settings that can be made in Taskbar and Start Menu.

Explain to the students the various settings that can be made for mouse pointer under Buttons,
Pointers and Pointer Options tabs of Mouse Properties dialog box.

Demonstrate the various ways in which sound settings of the speakers attached to the computer
can be controlled.

Open a window of MS Word and explain the various components of the window covering title bar,
control buttons, ribbon, work area, scroll bars, status bar and border.

Tell the students about the importance of Disk Cleanup utility and steps to run this utility on the
computer system.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

]
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Ask the students some oral questions based on this chapter.

Q. What is an operating system?

Q. What is Windows 7?

Q. What is the use of these features of Windows 7?

m Sneak m Aero flip m Jump list

What is Control Panel?

What is the difference between Taskbar and Notification Area?
Can we change date and time of the computer system?
What are the various tabs in Mouse Properties dialog box?
Name some components of an open window.

What is the use of Disk Cleanup utility?

OOOoOoLOoo

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 25 and
26 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Page 26. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 27 will enhance the
ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to collect information from the Internet about earlier versions of Windows like
Windows XP and Windows Vista. Tell them to make a comparative table about the various features
available in these earlier versions and Windows 7.

3. Moreron MS PowerPoint'2010

Teaching Objectives
Students will learn about

& Applying Themes & Adding Sound

@ Adding Video @ Slide Transition

@ Custom Animation @ Running a Slide Show

Teaching Plan Number of periods: 3

While teaching this chapter, tell the students that MS PowerPoint 2010 is used to create electronic
presentations.

Tell the students that a theme is a set of predefined layouts that can be used to add a professional
touch to the presentations.

Demonstrate the steps to choose a theme, change theme colours, fonts and backgrounds.
Show to the students how sound and audio files can be inserted into a presentation.

\
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Demonstrate the steps involved in inserting a video file into a presentation. (refer Suggested Activity
also).

Explain to the students that transitions are used to determine how the presentation moves from
one slide to the next.

Tell the students about the various categories of slide transitions available in MS PowerPoint.
Demonstrate the application of transitions to slides in a presentation.

Introduce animation as the feature that gives a moving effect to text and other objects on the slide.
Show to the students the steps involved in applying custom animation to various objects on a slide.
Tell the students the animation effects applied to different objects on a slide can be reordered.
Share with the students that running a presentation is called Slide Show.

Demonstrate to the students the various steps involved in running a slide show.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

Ask the students some oral questions based on this chapter.

Q. Whatis a theme?

Q. What do you mean by customizing a theme?

Q. Can you change background, colour, fonts, etc. of a theme?

Q. What type of audio files can be inserted into a presentation?

Q. Can we add video files on a slide?

Q. Define transition.

Q. How many transitions can be applied to a slide?

Q. What happens if more than one slide transitions are added to a slide?
Q. What is meant by animation in MS PowerPoint?

Q. Can we reorder the animations applied to different objects on a slide?
Q. What is a Slide Show?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 36, 37 and
38 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 38 and 39. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 39 will enhance the
ability of the students and serve as Subject Enrichment activities.

Suggested Activity

Divide the class into two teams. Ask one team to prepare charts on various types of pollution. Ask
the other team to prepare a PowerPoint presentation on the same topic. Make the students share
the benefits enjoyed and limitations faced by each team while working on their project.

]
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4. Moreon'MS Word 2010

Teaching Objectives
Students will learn about

& Find and Replace & Line and Paragraph Spacing

@ Page Margin & Page Orientation

& Watermark & Header and Footer

@ Inserting mathematical equations & Inserting SmartArt

@ Mail Merge

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that formatting refers to the appearance of a document.

Tell the students that a particular word or phrase in a document can be looked for with the help of
Find feature.

Tell them that MS Word can go one step ahead and can replace that particular word or phrase by
another word or phrase as required by the user using the Replace feature.

Demonstrate the steps to use Find and Replace features.
Explain to the students that line spacing means the blank space between two lines in a paragraph.

Further tell them that the paragraph spacing means the blank space between two consecutive
paragraphs in a document.

Activity can be created on the Orientation as Take two printouts in different orientations and display
them in from of the class to demonstrate the difference between orientations.

Tell the students that page margin is the white space all around the printed area of the paper.
Make the students understand how they can modify page margin settings for their document.

Introduce to the students the concept of orientation as the side of the paper along which the content
of the document will be printed.

Tell the students about different types of orientations.

Show to them the steps involved in changing the page orientation in a document.

Introduce the term watermark as the faded text or image behind the main text of the document.
Demonstrate the steps involved in inserting text and image as watermarks in your document.

Show to the students the main course book where book name and chapter name are appearing at
the bottom of each page. Tell the students that this is called Footer of a page.

Make them understand that if the same or some other text appears on top of each page, it is called
Header.

Demonstrate the steps involved in adding header and footer to a text document and tell them the
various type of information can be shown as header and footer.

Make the students that mathematical equations can be easily inserted in a document.

\

7 3
TouchPad Version 1.0-VI (Lesson Plan) ¢ 13 ¢

I

-



Show to the students the steps involved in inserting mathematical equations.

Make the students understand the steps involved in inserting a SmartArt in Word are same as those
discussed in inserting a SmartArt in PowerPoint.

Introduce to the students Mail Merge as the feature used to create personalized letters to be sent
to many persons.

Tell them the various steps involved in creating a mail merge (refer Suggested Activity also).
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is the difference between Find and Replace features?

What is the meaning of Line Spacing?

What is the meaning of Paragraph Spacing?

What do you mean by page orientation?

What are page margins?

Define a watermark.

What is the difference between header and footer in a document?

Which tab is used to add header/footer to a document?

What do you mean by Mail Merge?

DOOLOLOLOLOLDO

How is mail merge helpful?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 50 and
51 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 51 and 52. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 53 will enhance the
ability of the students and serve as Subject Enrichment activities.
Suggested Activity

Ask the students to create an electronic invitation (personalized) for inviting middle school teachers
to a thank you performance organized by Grade 6-8 students.

5. [Learning/MS Excel 2010

Teaching Objectives
Students will learn about

@ Starting MS Excel 2010 & Components of MS Excel 2010
@ Creating a new workbook & Entering data in a worksheet
& Modifying data & Column width and Row height

]
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@ Inserting rows / columns & Merging cells

@ Formatting spreadsheets @ Customize Worksheet tab
& AutoFill
Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that MS Excel is an application software that helps us
to store and analyse data.

Demonstrate the steps to start MS Excel 2010.

Show an active window of MS Excel 2010 and explain the meaning and use of the various components
of MS Excel 2010 covering title bar, file tab, quick access toolbar, ribbon, formula bar, name box,
worksheet window, status bar, row, column, cell, row and column headings, active cell, mouse pointer,
worksheet tab and workbook.

Show to the students how to create a new workbook in Excel.
Tell the students that to enter data in a cell, simply click on the cell and enter data.
Tell the students the methods of modifying data by cut, copy and paste.

Explain to the students the steps involved in changing row height and column width — both manually
and automatically.

Tell the students that Excel allows inserting blank rows and columns at the required place in the
worksheet.

Demonstrate to the students how two or more cells can be merged into one and also how a cell can
be split up into two or more cells (refer Suggested Activity also).

Explain some worksheet formatting features of Excel like

e Word wrap — displaying multiple lines of text in a cell

e Format numbers — applying various data types to the cells

e Cell borders — boundary around a cell or a series of cells

e Cell styles — Pre-defined cell border, colour and formatting

e Cell fills — adding colours or shades in the cells

Show to the students the steps involved in applying all of these formatting features on a worksheet.
Explain to the students that worksheet tab can be customized by changing its default name and colour.

Introduce to the students AutoFill feature of Excel as automatically filling a series of data in the
worksheet and the steps involved in the same.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is the use of MS Excel software?

Name any five components of an Excel window.

What is the difference between Cut and Copy options?

What does it mean when data in a cell is displayed as #####7?

Define merging of cells.

lelyelyel ey eNe

Define splitting of cells.

\
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Q. What is wrap text feature of Excel?

Q. Name any three number formats available in Excel.
Q. What is meant by border of a cell?

Q. What is the use of AutoFill feature?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 65 and
66 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 66 and 67. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 67 will enhance the ability of the
students and serve as a Subject Enrichment activity.

Suggested Activity
Ask the students to design their class time-table in MS Excel 2010.

6., Introduction/to Flash/CS6

Teaching Objectives
Students will learn about

@ Starting Flash CS6 & The Flash workspace

@ Tools panel & Creating a new Flash document

@ Saving a Flash file & Opening a Flash file

@ Exiting Flash

Teaching Plan Number of periods: 2

While teaching this chapter, tell the students that Flash is an application used in multimedia graphic
programs.

Show to the students the steps to be taken to start Adobe Flash CS6.

Start Flash on a computer and familiarize the students with the Flash workspace and its various
components covering:

e Menu bar — various options are categorized under menus.

e Stage — the white rectangular area of the workspace.

e Pasteboard - the grey area around the stage.

e Timeline panel — used to control images and sounds.

e Properties panel — used to define properties of various objects and controls.

e Tools panel — used to draw, paint, select and modify artwork and view of stage.

Introduce to the students the concepts of frame (single step of animation), layers (a way to
organize elements of a movie) and Options area (at the bottom of the tools panel used to
modify tool controls).

]
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Discuss with the students the names of the various tools in the Tools panel and tell them that the name
of the tool can be seen by placing the mouse pointer over the tool (refer Suggested Activity also).

Demonstrate the steps to create a new Flash document.
Show to the students the steps involved in saving a file in Flash CS6.
Tell the students that an existing file of Flash can be opened just like any other software as File — Open.

Show to the students the various ways in which Flash software can be closed after saving the work
done.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is Adobe Flash CS6 used for?

What are the various components of the Flash workspace?

Define stage.

What are the various panels in Flash?

What is the use of the Tools panel?

What is the file type selected from New Document dialog box?

What is the extension added to Flash CS6 files?

What is the shortcut to reach Open dialog box?

DOOOLLOLLOOLLOOL

State any two methods of exiting Flash.

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 77 and
78 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 78 and 79. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 79 will enhance the
ability of the students and serve as a Subject Enrichment activity.
Suggested Activity

Ask the students to draw a labeled diagram of the Flash Tools panel in your computer practical file
or notebook.

7., 'Using Tools/in Flash/CS6

Teaching Objectives
Students will learn about

@ Selection Tool & Line Tool
@ Pencil Tool @ Pen Tool
@ Rectangle Tool & Oval Tool
@ PolyStar Tool @ Eraser Tool

\
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< Paint Bucket Tool < View Tools

@ Colour Tools

Teaching Plan Number of periods: 3

While teaching this chapter, tell the students that the various tools present in the Tools panel are
quite helpful in creating drawings in Flash.

Demonstrate the use of some important drawing tools along with some of their important properties
to be defined in Flash CS6 covering:

Line Tool — used to draw straight line also mention Selection Tool between two points. The
properties to be defined are Stroke Color, Stroke Height, Stroke Style and Cap.

Pencil Tool — used to draw freehand lines and curves. The properties to be defined are Stroke
Color, Stroke Height, Stroke Style and Cap.

Pen Tool — used to draw straight lines or smooth flowing curves. The properties to be defined
are Stroke Color, Stroke Height, Stroke Style and Cap.

Rectangle Tool — used to draw closed rectangles and squares. The properties to be defined are
Stroke Color, Fill Color, Stroke Height and Stroke Style.

Oval Tool — used to draw closed circular shapes. The properties to be defined are Stroke Color,
Fill Color, Stroke Height and Stroke Style.

PolyStar Tool — used to draw closed shapes like triangles and those having five or more sides.
The properties to be defined are Style and Number of Sides.

Eraser Tool — used to remove unwanted parts or whole objects from the stage. The application
of different properties of eraser (Faucet and Drag modes) and different types of modes (Normal,
Fills, Behind, Selected Fills and Inside) need to be shown to the students.

Paint Bucket Tool — used to fill colour in closed shapes. The properties to be defined are Fill Color.

Text Tool — used to place text blocks on stage. The properties to be defined are Family, Style,
Size, Color and Spacing.

Explain the use of the View tools in Flash CS6 covering:

Hand Tool — used to move to different parts of the stage without changing the view of the stage.
Zoom Tool — used to adjust magnification of the stage.

Show to the students the functions of Colour tools in Flash covering:

Stroke Color — used to change colour of the boundary of a shape.
Fill Color — used to change the inside shape color.

(refer Suggested Activity also).

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

Ask the students some oral questions based on this chapter.

Q.

Q.
Q.
Q

What is the use of Tools panel?
What is the use of Pen / Pencil / Text / Eraser tools?

What are the different properties that need to be defined for Line / PolyStar / Rectangle / Oval
tools?

Which key is pressed to draw a square or a circle?

]
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Q. Under which tool is the Oval / PolyStar tool hidden?
Q. Name three modes in which Eraser tool is used.

Q. What is the use of View tools?

Q. Name the two Colour tools in Flash.

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 87 and
88 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 89 and 90. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 89 will enhance the
ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to create a drawing of robot in Flash CS6 using various tools available in the Tools
panel.

8. (Computer Programming

Teaching Objectives

Students will learn about

& Computer Program & Computer Languages
@ Language Translator @ Algorithm

@ Flowcharts

Teaching Plan Number of periods: 3

While teaching this chapter, tell the students that computer needs a special language through which
we can communicate with it.

Ask the students to learn some important computer terms like:

e Program - a set of instructions given to CPU in a pre-defined sequence to complete a task.

e Computer language — means by which data and instructions are transmitted to the computer.
e Syntax — the grammar of a computer language.

e Programming — process of writing a program.

e Programmers — people who write computer programs.

Tell the students that computer languages are categorized as low-level languages (machine
dependent) and high level languages (machine independent).

Share with the students that low level languages are further classified as machine language (first
generation language made up of Os and 1s) and assembly language (second generation language
made up of alphanumeric symbols).

\
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Make the students learn that the high level languages are further classified as third generation
languages (examples: BASIC, COBOL, FORTRAN, PASCAL, etc.), fourth generation languages (examples:
Visual Basic, Oracle, SQL, JAVA, C++, etc.) and natural language or fifth generation languages
(involving artificial intelligence).

Tell the students the advantages and disadvantages of high level languages over low level languages.

Introduce the concept of language translators as software that convert a high level language into
a machine language covering:

e Assembler — used to translate assembly language into machine language.
e Compiler — used to convert source program at once into machine language before executing it.

e Interpreter — used to convert source program one line at a time into machine language before
executing it.

Introduce algorithms as set of steps in a sequential and ordered manner to solve any problem or
to complete a task.

Encourage the students to write algorithms involving some basic tasks like getting ready for school
or involving mathematical problems like addition and subtraction of numbers (refer Suggested
Activity also).

Introduce flowcharts as diagrammatic representation of an algorithm.

Explain the shapes and usage of flowchart symbols covering Start / Stop box, Process box, Decision
box, Input / Output box, Flow lines and Connectors.

Make the students learn the rules for drawing a flowchart.

Encourage the students to draw flowcharts for the algorithms written earlier.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is a program?

Who is a programmer?

What do you mean by computer language?

What is the meaning of syntax?

What are the categories of computer languages?

Define compiler / interpreter/ assembler.

OOoOLOOLOLOL

What is the purpose of developing algorithms and flowcharts?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 99 and
100 as One Touch Learn and Let’s Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 101 and 102. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 102 will enhance the
ability of the students and serve as a Subject Enrichment activity.

Suggested Activity
Ask the students to write algorithms and draw corresponding flowcharts to:
e Calculate area of circle, A = nr?

]
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e Calculate Volume of cube, V.

cube

= (side)?

e (Calculate Volume of cuboid, V = length x breadth x height

O. VWisual Basic9

Teaching Objectives

Students will learn about

@ Microsoft Visual Basic @ Starting Visual Basic
@ Toolbox @ My First Application
@ Developing Sum Calculator Application

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students about a brief history of evolution of computer
programming.

Introduce Microsoft Visual Basic as a software used to develop Windows based applications and
software.

Demonstrate the steps involved in starting Visual Basic.
Tell the students about drag and drop feature of Visual Basic.

Familiarize the students with the Toolbox and some commonly used tools covering Pointer, Label,
Button, TextBox, CheckBox, RadioButton, ListBox, ComboBox, PictureBox, Date TimePicker and
Month Calendar.

Make the students understand the various situations in which each of these tools is used.

Demonstrate to the students the process of developing a simple Visual Basic application titled as
'My First Application’ (refer Pages 106 to 108 of the course book).

Encourage the students to develop Sum Calculator Application closely following the steps detailed
on Pages 108 to 110 of the course book.

Help the students in developing the application. (refer Suggested Activity also).
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

Q. Who claims the credit for computer programming?
Q. For which machine was the first computer program developed?
Q. List three benefits of using MS Visual Basic.
Q. What is Toolbox?
Q. What do you mean by drag and drop feature of Visual Basic?
Q. Give use of these tools:

H  Pointer

B Label

B Button

\
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TextBox

ListBox

Month Calendar
PictureBox

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 111 and
112 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Page 113. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Pages 113 and 114 will enhance the ability
of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to develop a basic application where the teacher enters the marks of the students
in five subjects and the application calculates total marks scored, average marks, percentage and
highest marks for each student.

]
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1., Computer/Software

One Touch Learn )

E’:Ji ) "Y(

A. 1 (o 2. (0 3. (b) 4. (c)
B. 1T
2. F Correct Statement: A computer system is made up of a number of hardware devices

and software.

3. F Correct Statement: Virus scanner is used to scan files and folders for virus.
4. F Correct Statement: DBMS is a general purpose application software.

C 1. instructions 2. operating system
3. application software 4. disk defragmenter

D. 1 d 2. ¢ 3. a 4. e 5 b

ats oo

A. 1. An electronic device that performs diverse operations with the help of instructions to
process the data in order to achieve desired results.

2. An operating system is the most important software that runs on a computer. It manages
the computer's memory, processes data and controls all its software as well as hardware.

3. Multimedia software are used to combine the text with graphics, videos and sounds.

4. Application software is a program designed to help users to perform specific tasks.
MS Word, MS Excel and MS PowerPoint are application software.

B. 1. System software is the mostimportant component to operate a computer. System software
can be classified into three categories:

(i) Operating System
(i) Programming Software
(iii)  Utility Software
2. Application software can be of two types:

() General purpose software: General purpose software are those which have not
been developed according to the needs of a particular organization.

(Aoy 1amsuy) |[A — 0°L UOISIDA AYdHONOL

\

. .
TouchPad Version 1.0-VI (Answer Key) { 23®

T

-



(i) Customised software: Customised software are those which have been developed
according to the needs of a particular organisation or an individual.

Some examples of application software are Microsoft Word, Microsoft Access, and
Windows Movie Maker.

Crack The Code

A. 1. Word Processors 2. Antivirus 3. Data Compression Program

o
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Do yourself.

2., 'Windows 7

A. 1. (b) 2. (0 3. (0 4. (a)

B. 1. F Correct Statement: Windows 7 was launched in 2009.
2. T 3.7 4. T

C. 1. Taskbar 2. Recycle bin
3. Notification Aread4.  Aero flip

o’

A. 1. Ajump listis afeature introduced in Windows 7 that allows you to view recent documents
in a program that is pinned to the taskbar.

2. The Disk Cleanup tool is used to search on the hard disk for files that can be deleted from
your computer without affecting its functions or your personal files.

3. Status bar shows various information about the file in which you are working.
4. Five components of an active window are:
(i) Title bar
(i) Control Buttons
(iii) Scroll bars
(iv) Work area
(v) Status bar

B. 1. Snap feature arranges two windows side by side exactly to fill half the screen each and
Aero Flip feature shows you what is happening in all other open windows on the computer
system.

2. To open Control Panel:

]
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Step 1 Click on Start button.
Step 2 Click on Control Panel.
3. To change date:
Step 1 Click on the Clock, Language, and Region option from the Control Panel.
Step 2 Click the Date and Time option.
Step 3 Click Change Date and Time button.
Step 4 Select date and month from the calender.
Step 5 Click on OK button.
Step 6 Click on OK button.

o)
Crack The Code %)

A. 1. By changing Mouse setting from Right handed to Left handed in the Mouse Properties
dialog box, the mouse is configured for left handed person.

2. By using the Disk Cleanup tool, junk files can be deleted from the computer.

>
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Periodic/Assessment-1
(Based on chapters 1 & 2)

Disk Cleanup tool is used to delete temporary Internet files and Windows temporary files.
The section at the right end of the Taskbar is called Notification Area.
Recording tab is available in the Sound dialog box.

Word Processors software are used to create, edit and format text documents. Microsoft
Word is an example of Word Processors software.

Database Management System (DBMS) software are used to create, store, modify and sort
data stored in a database. Microsoft Access is an example of DBMS.

Spreadsheet software are used to calculate, compare and analyse data and used to prepare
different reports. Microsoft Excel is an example of Spreadsheet software.

DeskTop Publishing (DTP) software are used to create newspapers, magazines, brochures,
still advertisements, etc. Adobe InDesign is an example of DTP software.

Presentation software are used to create presentations which include sound, music, video,
charts and animation. Microsoft PowerPoint is an example of Presentation software.

Application software 2. Calc 3. Adobe InDesign 4. Share
C 2. e 3. a 4. b 5 d

3., Moreion MS PowerPoint 2010

One_
A1

D.

1

I

(@, b, 0 2. (0 3. (d) 4. (b) 5. (b) 6. (b)
T 2. T 3. T

F Correct Statement: To hide background graphics in the design theme, click the Hide
Background Graphics.

F Correct Statement: You can change the order of the animation on an object, by clicking
move earlier or move later commands.

F Correct Statement: To preview an effect from the animation pane click, Play button.

one or more 2. presentations 3. animation
ribbon 5. slide 6. create
d 2. a 3. b 4. ¢

o’

A.

]

1. Aslide is a single page of a presentation.
2. Transition determines how your presentation moves from one slide to the next.
3. Slide transition is applied on the slides and animation is applied on the objects of the slides.

C 2N
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. To apply design themes:

Step 1 Click on the Design tab.
Step 2 Place your mouse pointer over any of the theme in the Themes group.
Step 3 Click the design theme thumbnail when you find one that suits your needs.

. Toinsert Clip Art:

Step 1 Click on Insert tab.

Step 2 Click on Clip Art command.

Step 3 Enter keyword in the Search for: text box in the ClipArt pane.
Step 4 Click on the image you want to insert in a slide.

To insert a picture:

Step 1 Click on the Insert tab.

Step 2 From the Images group, click on the Picture command. The Insert Picture dialog
box appears.

Step 3 Select the desired image file and click on Insert button.
a. To insert a new slide:

Step 1 Click on Home tab on the ribbon.

Step 2 Click on the New Slide button. Select the type of slide you want to insert.
b. To delete a slide:

Step 1 Select the slide you want to delete.

Step 2 Right-click on the slide and choose Delete Slide from the pop-up menu.
c. To rearrange the slides:

Step 1 Click on Slide Sorter View command from the Presentation Views group in the
View tab.

Step 2 Click and drag the slide which you want to rearrange.

. To apply animation to text or objects:

Step 1 Click on the image or the text you would like to animate.

Step 2 Click Animations tab.

Step 3 You can either open the Animation pane or use the drop-down list.
Step 4 Select the animation effect you would like.

Step 5 Specify whether you want your animation to start On mouse click, After previous
or With previous.

Crack The Code %

A.

1. By using Themes, Sumit can add a background to his presentation.
2. By using Animation, Pooja make the objects appear in a different way.
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4. Moreon'MS Word 2010

One  Touch Learn )

A.

1
1
4.
1
4

(a, b) 2. (0 3. (a)
. T 2. T 3.7
F Correct Statement: Paragraph spacing can be changed in a document.
page 2. watermark 3. footer
buttons 5. page orientation

oo

A.

]

—

1.

Formatting refers to the layout of a paper and it is important to format a document to
make it more understandable and attractive.

Header is the text that appears at the top of each page of the document and Footer is the
text like page number that appears at the bottom of each page of the document.

Page margins are used to add blank space around the text of the document so it is easy
to bind the papers.

The Header or Footer are used to save time and effort of the operator to enter same text
on each page. It also reduces chances of errors like missing to enter details on a page. To
add a header or footer:

Step 1 Click on the Insert tab.

PR
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Crack The Code

A. 1. Mail Merge 2. Watermark

Step 2 Click on Header or Footer command from the Header & Footer group.

Step 3 You can choose from various available header/footer templates or choose Blank
option to enter text of your choice.

Step 4 This will open the respective Header or Footer section of the page. You can type
the text you want to appear on each page.

The Mail Merge feature in MS Word is used to create personalised letters to be sent to
many persons. It saves a lot of time, as you do not need to change the information for
every person manually.

To find a word:

Step 1 Click on the Find command on Home tab. This will open Navigation panel on the
left side of the MS Word window.

Step 2 Type the word or phrase in the text box.
Step 3 Click on the Search icon on the right side of the text box or press Enter key.

Step 4 The lower part of the Navigation panel will display a list of occurrences of the
required text or phrase.

Step 5 Press Enter key to move to the required occurrence of the text.
To replace a word:

Step 1 Click on the Replace command on Home tab. This will open Find and Replace dialog
box.

Step 2 Type the existing word or phrase that is to be changed in the Find what text box.
Step 3 Type the new word or phrase in the Replace with text box.

Step 4 Click on Find Next and Replace buttons for selective replacement of the text or
click on Replace All button to replace all occurrences of the existing text with the
new text.

To insert mathematical equations:

Step 1 Click on the Insert tab.

Step 2 In the Symbols group, click on the down arrow under the Equation command.
Step 3 Click on the Insert New Equation.

Step 4 A blank equation box saying ‘Type Equation here' appears on the document.

Step 5 You can enter the equation using number keys on the keyboard and symbols on
the ribbon under Design tab.

\
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Do yourself.

5. [Learning/MS Excel 2010

A.
B.
C.

1
1
1

(d) 2. (a) 3. (8,0 4. (o)
T 2. T 3.7 4. T
Excel 2. create 3. program 4. merge cells

o’

A.

fg;é‘»‘\

1
2.

3.

Spreadsheet is a program that allows you to store and analyse numerical data.

The horizontal divisions on a worksheet are called rows and vertical divisions on a worksheet
are called columns.

AutofFill feature automatically fills a series of data in your worksheet.

f 30 L TouchPad Version 1.0-VI (Answer Key)
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B. 1. Thedatainthe form of numbers or text can be entered by just clicking on a cell and typing
with the help of a keyboard. You can type data directly into the cell, or you can enter data
using the Formula bar.

2. To set column width/row height:
Step 1 Select the column(s) or row(s) that you want to change.
Step 2 Click on Format command in Cells group from Home tab.
Step 3 Choose Column Width or Row Heights under Cell size from the drop-down list.
Step 4 A Column Width or Row Height dialog box will appear.

Step 5 Inthe Column Width or Row Height box, type the value that you want your column
or row to be.

3. To apply cell border:

Step 1 On a worksheet, select the cell or range of cells that you want to add a border to,
change the border style on, or remove a border from.

Step 2 Go to the Font group in the Home tab.
Step 3 Click the arrow next to Borders command.
Step 4 Click on the border style you would like.

Crack The Code

A. 1. Byusing the Wrap Text command present on the Alignment group in the Home tab, Sonia
can make the text visible.

2. By inserting a column, Anaya can create space to enter the marks.
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1. To add a row above fifth row:
Step 1 Select the fifth row by clicking on the row heading.
Step 2 Click on Insert command in the Home tab.
Step 3 Click the Insert Sheet Rows option.
2. Toinsert a column to the right of third column:
Step 1 Click and select the fourth column heading.
Step 2 Click on Insert command on the Home Tab.
Step 3 Click on Insert Sheet Columns option.
3. To fill roll numbers from 1 to 11:
Step 1 Enter the first two numbers 1 and 2.
Step 2 Select both the cells containing the numbers you have entered.

Step 3 Position the mouse pointer over the bottom right corner of the last selected cell.
The pointer changes to (+) sign.

Step 4 Drag the mouse pointer over the cells you want to include in the series.

Periodic/Assessment-2
(Based on chapters 3 to 5)

A. 1. Ctrl+ F 2. Ctrl + H 3. Esc

4. Shift + F5 5. Ctrl + X 6. Ctrl +V
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Test Sheet-1

(Based on chapters 1to 5)

Section A
(d) 2. (b) 3. (0 4. (a,b) 5. (a)
presentation 2. object 3. orientation 4. page 5. create
Record button: It is used to start recording your voice.
Preview Results: It is used to see the preview of mail merge.
Orientation: It is used to define orientation of the page.
Stop Record button: It is used to stop the recording.
Border: It is used to set the border of a cell or text.
SmartArt: It is used to represent food chains or hierarchy series.
T 2. T 3.7
F Correct Statement: Paragraph spacing can be changed in a document.
T

Section B
Slide transition can be applied on the slides of a presentation whereas animation can be
applied on the objects of a slide.
A slide is a single page of a presentation.
Page margin is the white space all around the printed area of the paper.

The horizontal divisions on a worksheet are called rows and the vertical divisions on a
worksheet are called columns.

Spreadsheet is a program that allows you to store and analyse numerical data.

1. Toinsert Clip Art:

Step 1 Click on Insert tab.

Step 2 Click on Clip Art command.

Step 3 Enter keyword in the Search for: text box in the ClipArt pane.
Step 4 Click on the image you want to insert in a slide.

To insert a picture:

Step 1 Click on the Insert tab.

Step 2 From the Images group, click on the Picture command. The Insert Picture dialog
box appears.

Step 3 Select the desired image file and click on Insert button.

The Header or Footer are used to save time and effort of the operator to enter same text
on each page. It also reduces chances of errors like missing to enter details on a page. To
add a header or footer:

Step 1 Click on the Insert tab.

Step 2 Click on Header or Footer command from the Header & Footer group.

Step 3 You can choose from various available header/footer templates or choose Blank
option to enter text of your choice.

\
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Step 4 This will open the respective Header or Footer section of the page. You can type
the text you want to appear on each page.

. The Mail Merge feature in MS Word is used to create personalised letters to be sent to

many persons. It saves a lot of time, as you do not need to change the information for
every person manually.

To apply cell border:

Step 1 On a worksheet, select the cell or range of cells that you want to add a border to,
change the border style on, or remove a border from.

Step 2 Go to the Font group in the Home tab.

Step 3 Click the arrow next to Borders command.

Step 4 Click on the border style you would like.

To set column width/row height:

Step 1 Select the column(s) or row(s) that you want to change.

Step 2 Click on Format command in Cells group from Home tab.

Step 3 Choose Column Width or Row Heights under Cell size from the drop-down list.
Step 4 A Column Width or Row Height dialog box will appear.

Step 5 Inthe Column Width or Row Height box, type the value that you want your column
or row to be.

6., Introduction/to Flash/CS6

A. 1 (b 2. (d)

C.

1
2.

3.
1

3. (a)
F Correct Statement: Animation effects can be added in Flash.

F Correct Statement: The white rectangular area of the Adobe Flash workspace is called
stage.

T 4. T
frame 2. layers 3. left 4. bottom

o

A.

]

1
2.
3.

Flash is a very useful application used in multimedia graphic programs.
ActionScript 3.0.
Yes, there are many ways to exit Flash.

(i) Click on Exit from File menu

(ii) Press Ctrl + Q keys

4. Text Tool, Pen Tool and Line Tool.

C 2N
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B. 1. To start Flash:
Step 1 Click on Start button.
Step 2 Click on All Programs.
Step 3 Click on Adobe Flash CS6 Professional.

2. Properties panel allows you to set the properties of the objects that you have selected on
the stage. It also provides options to change the settings of the Flash document such as
stage dimensions and the animation’s frame rate.

3. To save a Flash file:
Step 1 Click on File menu.
Step 2 Click on Save to open Save As dialog box.
Step 3 Enter a name for the file in File name text box.
Step 4 Click on Save button.

Crack The Code %’)

A. 1. Sunidhi can place the objects on the pasteboard.
2. Options area
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To start Flash:

Step 1 Click on Start button.

Step 2 Click on All Programs.

Step 3 Click on Adobe Flash CS6 Professional.

/
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To create a new Flash document:

Step 1 Click on File menu.

Step 2 Click on New to open New Document dialog box.
Step 3 Select ActionScript 3.0 from the Type list.

Step 4 Click on OK button.

To save a Flash file:

Step 1 Click on File menu.

Step 2 Click on Save to open Save As dialog box.

Step 3 Enter a name for the file in File name text box.
Step 4 Click on Save button.

To exit Flash:

Click on Exit from File menu
Or

Press Ctrl + Q keys

Or

Press Alt + F4 keys

Or

Click on the Close button on top right corner of the Flash window.

7., 'Using Tools/in Flash/€CS6

One Touch Learn )

A. 1 (0 2. (d) 3. (a 4. (a)
B. 1T 2. T
3. F Correct Statement: We can change shape and size of an eraser.
4. T
C. 1. Pencil 2. circle 3. fill colour 4. Hand 5. Stroke

cood

A. 1. Stroke Height text box is used to change width or thickness of the line.
2. Freehand lines and curves.
3. Yes, there are some options:
(i) Oval Tool
(i) PolyStar Tool
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B. 1. Selection Tool: It is used to select and move objects.

Hand Tool: It is used to move to different parts of the stage without changing the view of
the stage.

2. Properties of a line are Stroke Color, Stroke Size, Stroke Style and Cap.

3. The main difference between Star and Polygon options is that the Star option creates a
star and the Polygon option creates a polygon with specified number of sides.

Crack The Code

A. 1. PolyStar Tool
2. Gishi can draw a square by using the Shift key with the Rectangle Tool.
3. Yes, Surabhi can remove some parts by using the Eraser Tool.
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Periodic/Assessment=3
(Based on chapters 6 & 7)
A. 1. Selection Tool 2. Hand Tool 3. Rectangle Tool
4. Line Tool 5. FEraser Tool 6. Pencil Tool
7. PolyStar Tool
B. 1. Rectangle
2. Rectangle

4
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One | Touch  Learn b
A. 1 (a) 2. (0 3. (b) 4. (o) 5. (o)
B. 1. F CorrectStatement: Assembly language is a second generation language.
2.7
3. F Correct Statement: A compiler or an interpreter is used to translate the entire source
code into machine language.
4. F Correct Statement: The programmer must always make a flowchart before writing a
program.
C. 1. data, instructions 2. programming 3. assembler
flow lines, arrows 5. consistent
N
(A

Lets Do It

A. 1. Anassembleris a program used to translate assembly language into machine language.
2. An Algorithm is a set of steps in a sequential and ordered manner to solve any problem.
3. Aflowchart is a type of diagram that represents an algorithm.
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B. 1. The main difference between HLL and LLL is that the LLL is machine dependent and HLL is
machine independent.

2. The advantages of HLL are:
e High level language is user friendly.

e High level language is similar to English with vocabulary of words and symbols, therefore
it is easier to run.

e High level language requires less time to write.
e High level language is easier to maintain.

3. A compiler and an interpreter are software that convert the entire source program into
machine language before executing it.

C. 1. Connector 2. Decision 3. Process 4. Input/ Output
Crack The Code
A. 1. a Input/Output b. Process ¢. Input/Output

2. Richa should make an algorithm before drawing a flowchart.
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Switch on main power
supply button
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Switch on the UPS
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Switch on the power supply
button of CPU box

!

Switch on the monitor
power supply button

“
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/ Read PR, T
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v
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'
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O, 'Visual Basic/9

One Touch Learn )

A.
B.

C.
D.

N

=Pk w

==

(b) 2. (@) 3. (b) 4. (b) 5. ()
T

F Correct Statement: Software developers use various programming languages to design
software.

F Correct Statement: Form is a window where all controls are put up.

F Correct Statement: The Backcolor of a Button dragged on Form can be changed.
F Correct Statement: Controls cannot be dragged and dropped on the Form.
Label 2. RadioButton 3. applications 4. ComboBox
property 2. command 3. control 4. software 5. window

n

This is because of its drag and drop feature. When you draw a control on your form, Visual
Basic automatically generates sets of commands about that control.

Programming is generally used to mean writing various lines of instructions to develop a
program that can work.

Used to run your application.

. Visual Basic is used to create windows-based applications. Not only this, but you can also

create programs which can be used on web browsers and mobiles. In short, all computer
software running on Windows operating system can be developed in Visual Basic.

Text of the Label control cannot be directly edited or changed whereas the information
typed in the TextBox control can be edited.

(i) The Button is the most commonly used control. It is used to start or stop a particular
process.

(i) A CheckBox is used when a choice has to be given to the user to select one or more
options from the given list of options.

(iii) The Label is used to display text which a user cannot directly edit or change.

F5 2. Ctrl + Shift + S 3. Ctrl +S 4. Ctrl + N
Label 2. Pointer 3. TextBox
Month Calendar 5. Button 6. CheckBox

\
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Crack The Code n>
A. 1. CheckBox 2. Label

B. 1. Visual Basic 2. Toolbox 3. ForeColor property
4. Message Box 5. Form

°
| FUN |in | LAB L4

* Do yourself
* To find the total of marks obtained in 5 subjects:
Step 1 Add six Label controls, six TextBox controls and a Button control on the form.

Step 2 Change the Text property of Labell, Label2, Label3, Label4, Label5 and Label6 controls
to Marks in Subject 1, Marks in Subject 2, Marks in Subject 3, Marks in Subject 4, Marks
in Subject 5 and Total Marks respectively.

Step 3 Change the Text property of the Button control to Total.

Step 4 Double click the "Total” button and write the following code where the cursor appears
to blink:

TextBox6.Text = Val(TextBox1.Text) + Val(TextBox2.Text) +Val(TextBox3.Text) +
Val(TextBox4.Text) + Val(TextBox5.Text)

Step 5 Now come to the Form Design Window, save the file and run it by pressing F5.
*  To calculate interest:
Step 1 Add four Label controls, four TextBox controls and a Button control on the form.

Step 2 Change the Text property of Labell, Label2, Label3, and Label4 controls to Principle,
Rate, Time, Simple Interest respectively.

Step 3 Change the Text property of the Button control to Find Interest.

Step 4 Double click the “Find Interest” button and write the following code where the cursor
appears to blink:

TextBox4.Text = (Val(TextBox1.Text) * Val(TextBox2.Text) * Val(TextBox3.Text))/100
Step 5 Now come to the Form Design Window, save the file and run it by pressing F5.

Periodic Assessment-4

(Based on chapters 8 & 9)
A. 1. Machine language 2. Assembler 3. Connector
4. RadioButton 5. Form

B. Step 1 Start.
Step 2 Read all three numbers and store them in A, B and C.
Step 3 Add two numbers A and B.
Step 4 Multiply the sum with the number C.
Step 5 Print the result.
Step 6 Stop.

]
\
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Start

Y

/ Input X, Y, Z /

No Is Yes
¢ X>Y?
No Yes No Yes
No Yes No Yes
—l \d —l \d
PrintX,Z,Y Print X,Y, Z Print Z, X, Y PrintY, X, Z PrintY, Z, X Print Z,Y, X

Y
Stop

Start

Y

/ Read P r, t /

Y

Calculate
SI=(P*r*t)/100

Y

/ Print SI /
Y

Stop

|
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. ATextBox is used to display information which has been entered by the programmer at the
time of designing the application or has been entered by the user during the execution of
the application.

2. The Pointer is used to select any control on the Form.

el

vk W

. AlListBox is used to display a list of items from which a user can select one or more options.

Test Sheet-2

(Based on chapters 6 to 9)

Section A
() 2. (b) 3. (d) 4. (a)
(b) 6. (0 7. (a) 8. (b
Programming 2. Connector, Flow Line 3. Timeline
Pencil 5. ComboBox 6. Label
Section B

. Yes, there are many ways to exit Flash.
(i) Click on Exit from File menu
(i) Press Ctrl + Q keys
Freehand lines and curves.
An Algorithm is a set of steps in a sequential and ordered manner to solve any problem.
Used to run your application.

Programming is generally used to mean writing various lines of instructions to develop a
program that can work.

Properties panel allows you to set the properties of the objects that you have selected on
the stage. It also provides options to change the settings of the Flash document such as
stage dimensions and the animation’s frame rate.

Properties of a line are Stroke Color, Stroke Size, Stroke Style and Cap.

. The main difference between Star and Polygon options is that the Star option creates a
star and the Polygon option creates a polygon with specified number of sides.

. The advantages of HLL are:
e High level language is user friendly.

o High level language is similar to English with vocabulary of words and symbols, therefore
it is easier to run.

e High level language requires less time to write.
e High level language is easier to maintain.

(@) The Button is the most commonly used control. It is used to start or stop a particular
process.

(b) A CheckBox is used when a choice has to be given to the user to select one or more
options from the given list of options.

e
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Start

!

/ Read A, B, C /

'

Sum=A+B+C

!

Prod=A*B*C

Y

Print
Sum and Prod

Stop

Start

{

Read A
count=1

count=count +1

Y

No

Stop
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PRACTICE WORKSHEET

1., Computer/Software

A. Tick (v)) the correct option.

1. What do you mean by multimedia software?

Define programming software.

What is the use of backup utility?

What is system software? What are the different types of system software?

M 1. is an operating system.
I a. MS Word b. MS Excel c. MS Windows d. None of these
v 2. is not a programming software.
> a. Compiler b. Spreadsheet c. Interpreter d. Assembler
U 3. MS Access is an example of .
< a. DTP b. DBMS c. Word processor d. Spreadsheet
(¢»] 4, refers to physical components that make up a computer system.
; a. Hardware b. Software c. Operating system d. None of these
L[]
Q© B. Classify these logos into different types of software stating their main category and
- | sub-category.
- '
. 1. ~. 2. @ 3. 'w: 4. 5. e
] MacOS ooy =
s C. State whether the given statements are True or False.
— 1. Virus scanner is used to scan only folders for virus.
;? 2. Disk defragmenter organizes continuous blocks into fragments of files.
n 3. System software is the most important component to operate a computer.
~ 4. A computer system is made up of a number of software devices.
m 5. Data compression program is used to compress large sized file into a
g smaller size file.
; D. Answer these questions.
n
=
(]
m
L)

vk W

Write a detailed note on general purpose software.

Note: More Worksheets are available online. Visit www.thetouchpad.com
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2. 'Windows!7

A. Tick (v) the correct option.

1

2.

3.

feature of Windows 7 shows you what is happening in all other open
windows on the computer system.

a. Sneak b. Aero Flip

c. Shake d.  Jump List

The section at the right end of the taskbar is called

a. Title Bar b. Status Bar

c. Notification Area d. Quick Access Toolbar
The tab is not present on the Mouse Properties dialog box.
a. Buttons b. Arrow

c. Pointers d. Pointer Options

setting in Control Panel is used to adjust the visual effects of the computer.

a. Hardware and Sound b. Programs
c. System and Security d. Appearance

B. WhoamI?

1
2.
3.
4.

I am used to move up and down in an active file.

I show information about the file you are working in.

I am used to hide the active window.

I display the name of the program and name of the file you are working in.

C. State whether the given statements are True or False. Correct the false statements.

1
2.

3.
4.

Taskbar is the bar that is displayed at the bottom of the monitor.

Playback tab in Sound dialog box is used to connect computer to a
telephone line.

Windows 7 was launched in 2007.
To see jump list, right-click on any program icon in the taskbar.

D. Answer these questions.

1.
2. What is the use of Disk Cleanup?

3.

4. What is the difference between the Shake and Snap features of Windows 77

Name the default tab that opens in the Mouse Properties dialog box.

Define Jump list.

Note: More Worksheets are available online. Visit www.thetouchpad.com

\
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PRACTICE WORKSHEET

3., Moreion MS PowerPoint 2010

A. Tick (v)) the correct option.

1. A is made up of several slides.
a. document b. presentation
c. animation d. transition
2. A is a set of pre-defined layouts that can be used to add a professional touch
to the presentation.
a. theme b. animation
c. slide Show d. transition
3. Animation is used to hold the of the audience.
a. attendance b. attention
c. absence d. arrival
4. To preview transition of current slide, we click .
a. Preview button b. Slide show button
c. Bothaandb d. None of these

B. Match the commands in Column I with the corresponding tab in Column II.

Columnl Column I
1. Colors a. Animations
2. Video b. Slide Show
3. Preview c. Design
4. From Beginning d. Start Slide Show
5. F5 e. Insert

C. State whether the given statements are True or False. Correct the false statements.

The Audio command is present on the Home tab.

We can add video files to our presentation.

To change the colour in the slide theme, click on the Colors command.
To create a new presentation, we click on the File tab.

To preview an effect from the Animations pane, click stop button.

vk W

D. Answer these questions.

Define a slide.

Give one difference between slide transition and animation.
What is the importance of the Design tab?

How will you insert ClipArt and pictures in your presentation?
What are the steps to preview a slide show?

vk Wi

Note: More Worksheets are available online. Visit www.thetouchpad.com
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4. Moreon'MS Word 2010

A.

Tick (v) the correct option.

1

2.

3.

4.

is a faded text or image that you want to appear behind the text on each

page.
a. Watermark b. Orientation

c. Spacing d. Footer

The Mail Merge feature is used to create to be sent to many persons.
a. Advertisements b. Personalized letters

c. Slides d. Handouts

Watermark in a document can be

a. Image b. WordArt

¢. Chart d. SmartArt

A header is printed in the margin.

a. Top b. Bottom

c. Left d. Right

Name the tool/command and state its use.

1.

A=~ ! B TT );J

2. 3. 4. 5.

State whether the given statements are True or False. Correct the false statements.

1.

vk wnN

Page Margin is the white space all around a text box.
The Orientation command is present in the Insert tab.
SmartArt is used to add charts in a document.
Paragraph spacing cannot be changed in a document.
Formatting refers to the layout of a paper.

Answer these questions.

1.
2.

What does the landscape orientation mean?

Under which tab is the Date & Time command present to be inserted in Footer of a
document.

What is the shortcut key to close the header and return to the normal document?
How are mathematical equations added in a document?
How do you use Find and Replace feature of Word?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

5. [Learning/MS Excel 2010

A. Tick (v)) the correct option.

1.

2.

3.

4.

is an application software that helps us to store and analyse data.
a. MS Word b. MS Excel

c. MS PowerPoint d. MS Windows

You can display multiple lines of text inside a cell using feature.
a. Merge and Center b. Alignment

c. Wrap text d. Autofill

Cell is the intersection of

a. Row b. Column

c. Bothaandb d. None of these

Row includes references.

a. Horizontal b. Vertical

c. Diagonal d. None of these

B. Whoam]I?

1. Ishow the address of the active cell.

2. Tam a vertical division on a worksheet.
3.
4
5

I am a collection of different worksheets.

. T'am the default row height in an Excel spreadsheet.
. I am the feature used to divide a cell into many cells.

C. State whether the given statements are True or False. Correct the false statements.

1
2.

The first electronic spreadsheet was MS Excel.

Excel replaces existing data in the paste area when you cut and paste cells
to move them.

Microsoft Excel is a spreadsheet application.
AutoFill allows users to automatically fill a number or text series.

The MS Excel ribbon contains multiple tabs, each with several groups of
commands.

D. Answer these questions.

1.

vk Wi

What is the use of Quick Access Toolbar?

Define active cell.

How will you change the row height and column width?
How will you insert data in a worksheet?

How will you apply cell borders?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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6., Introduction/to Flash/CS6

A.

Tick (v) the correct option.

1. The layer controls appear on side of the Timeline panel.

a. Left b. Right
c. Upper d. Lower

2. Flash CS6 adds the extension to all the saved files.
a. .flc b. fls
c. .fla d. .cs6

3. The is the grey colour area around the stage.
a. Tools panel b. Timeline panel
c. Edit bar d. Pasteboard

4. The option for creating a new file in Flash is present in menu.
a. File b. Edit
c. Insert d. Text

Write the shortcut keys used while working in Flash CS6 to
Create a new file

Open an existing file
Save a file

Exit Flash using Ctrl key
Exit Flash using Alt key

A wN e

State whether the given statements are True or False. Correct the false statements.

1. When you first launch Flash, the first thing you see is the Welcome screen.

2. If the Tools panel is not visible, you can display it by selecting Tools option
from View menu.

3. Animation effects cannot be added in Flash.
4. The object you placed on the stage will appear in your published movie.
5. Aframe is a single step of animation on the timeline.

Answer these questions.

Name the file type selected in New Documents dialog box.
What is the use of Options area?

What is Flash?

What are the uses of Property panel?

List the steps to save a Flash document.

v wnN e

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

7., 'Using Tools/in Flash/CS6

A. Tick (v)) the correct option.

1. To complete an open path, anywhere away from the path.
a. Left-click b. Right-click
c. Double-click d. Control-click
2. mode is used to erase the blank areas of the Stage leaving strokes and fills
unaffected.
a. Erase Fills b. Erase Behind
c. Erase Selected Fills d. Erase Inside
3. tool is used to draw an octagon.
. PolyStar b. Polygon
c. Rectangle d. Hand
4. key is pressed to make a circle while drawing an oval.
a. Shift b. Ctrl
c. Alt d. Windows

B. Identify and name these tools. Also state the use of these tools in Flash CS6.

1._\ 2 2

5 S .
5. N

C. State whether the given statements are True or False. Correct the false statements.

1. The simplest path you can draw with the Pen tool is a triangle.

2. If you double-click on the eraser tool, it erases the entire content from
the stage.

3. The PolyStar tool can be seen in the drop-down menu of the Rectangle tool.

4. We can click on the Cap to open drop-down menu for start and end style
of a line.

5. The Pen tool is used to draw any shape which is not there in the Tools panel.

D. Answer these questions.

1. What can be drawn with the PolyStar tool?

Is there any option available under Rectangle drop-down menu? If yes, list any two.
What are the various modes in which eraser tool can be used?

List the properties of a line defined in the Properties panel.

What is the difference in using a star option and polygon option in the Tool setting dialog
box?

vk wnN

Note: More Worksheets are available online. Visit www.thetouchpad.com
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8. (Computer Programming

A.
1.
2.
3.
4.
B.
1.
2.
3.
4.
5.
C.
1
2.
3.
4
5
D.
1.
2.
3.
4,
5.

Tick (v) the correct option.

is the grammar of a computer language.

Syntax b. Program
Instruction d. Algorithm
box shows an action step.
Terminal b. Process
Decision d. Connector
is a third generation language.
a. High level language b. Machine language
c. Assembly language d. Low level language
A computer programmer draws a before writing a computer program.
a. Algorithm b. Flowchart
c. Scenery d. Syntax

Match the commands in Column I with the box used in flowcharts in Column II.

Column Column II
Read P for Principal a. Process box
IsA>B b. Input box
End ¢.  Output box
Print Sum d. Decision box
A=B+C e. Terminal box

State whether the given statements are True or False. Correct the false statements.

Connector is used to a jump from one point in the flowchart to another.
Only one flow line should come out from a decision box.

Assembly language is a first generation language.

A good flowchart will use consistent symbols.

The process of writing a program is called formatting.

Answer these questions.

What is an assembler?

What is the difference between High Level Language and Low Level Language?
What is the use of compiler and interpreter?

Write an algorithm to find product of three numbers.

Draw a flowchart to find area and perimeter of a rectangle.

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

9., 'Visual Basic/9

A.

Tick (v') the correct option.

1

Visual Basic 1.0 was introduced in .
a. 1951 b. 1967

c. 1975 d. 1991
Visual Basic is use to create based applications.
a. DOS b. Android
c. Windows d. MacOS
Commands for the program are typed in window.
a. Word b. Design
c. Code d. Form

is the shortcut to run an application.
a. F1 b. F3
c. F5 d. F7

control is used to select only one option from the given list of options.
. ListBox b. ComboBox

c. PictureBox d. RadioButton

What type of controls can be used for these.

v wNh e

To display list of items from which user can select one or more options.
To enter a number for calculation in a program.

To select one or more options from a list of options.

To display some information which cannot be added by the user.

To select date to time as an option.

State whether the given statements are True or False. Correct the false statements.

1

vk W

A CheckBox is the same as the ListBox with single option displayed by
default.

The Properties Window is a window where all controls are put up.
Software developers use various human languages to design software.
The Backcolor of a Button dragged on Form cannot be changed.

The drag and drop generator for Visual Basic was developed by
Alan Cooper.

D. Answer these questions.

1

vk wnN

What is programming?

What is the use of debugging button?

Which feature of Visual Basic makes it easy to develop an application? How?
Write a short note on evolution of computer programming?

What makes Visual Basic a popular program to develop applications?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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LESSON PLAN

1., INumber System

Teaching Objectives

Students will learn about

@ Number system

@ Decimal to Binary conversion
@ Binary to Decimal conversion
@ Operations on Binary numbers

Teaching Plan Number of periods: 3
While teaching this chapter, tell the students that a number system is simply a method of counting.
Introduce base or radix as the total number of digits used in a number system.

Inform them that there are four important types of number systems — Decimal (base 10), Binary (base
2), Octal (base 8) and Hexadecimal (base 16).

Make the students recall the method of writing expanded form of a number under Decimal number
system.

Inform them that just like decimal number system:

« Add one more bullet In decimal number system, the numbers are expressed using ten digits,
0 to 9 and expanded with base 10.

« In octal number system, the numbers are expressed using eight digits, 0 to 7 and expanded with
base 8.

* In hexadecimal number system, the numbers are expressed using fifteen digits, 0 to 9 and
A to F, and expanded with base 16.
Show to the students the method of converting:

« Decimal number to Binary number by successive division by 2 and arranging the remainders in
reverse order (Refer Suggested Activity 1 also).

 Binary number to Decimal number by multiplying digits with 2 raise to the power of place of that
digit starting from 0 on the left (Refer Suggested Activity 2 also).
Share the rules of binary addition, subtraction, multiplication and division.

Show to the students the method of carrying out mathematical operations on binary numbers and
verifying the results by corresponding conversions to decimal numbers.

|

A
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Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is a numbers system?

What is the radix of decimal / binary / octal / hexadecimal number system?

Which digits are used to express a decimal / binary / octal / hexadecimal number?
What is the value of addition of binary digits 1 and 1?

What is the value of subtraction of binary digits 0 and 17

OOoOOLDo

Which number system is used by computers?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 13 and
14 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Page 15. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 15 will enhance the
ability of the students and serve as a Subject Enrichment activity.

Suggested Activity
1. Convert the last four digits of your parents’ mobile numbers into binary number.

2. Askthe students to prepare a comparative chart with four columns, the first one listing the digits
used in Hexadecimal number system and in the remaining three columns, their equivalent value
under decimal, binary and octal number systems.

2, [Formulas; Functions/and Charts in Excel

Teaching Objectives
Students will learn about
< Formula basics

@ Order of Operation

& Cell referencing in formulas and its types

& Functions

@ Charts in Excel

Teaching Plan Number of periods: 5

While teaching this chapter, tell the students that MS Excel has some built-in formulas called functions.
Share with the students the basic elements and rules of writing a formula in Excel.

Show to them the different methods of copying and pasting a formula.

Tell them the order of operation followed in Excel.

]
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Introduce cell referencing as use of cell address while writing a formula.

Make them understand the different types of cell referencing and the difference between the
three — Absolute, Relative and Mixed.

Tell the students about rules for using Functions and different categories of Functions in Excel.

Demonstrate the use of mathematical functions — SUM, PRODUCT, MOD, SQRT, INT, POWER and
COUNT.

Demonstrate the use of text functions — CONCATENATE, LEFT, RIGHT, LEN, UPPER and LOWER.
Demonstrate the use of logical functions — MAX, MIN and AVERAGE.

Demonstrate the use of date functions —- TODAY, MONTH, YEAR and DAY (Refer Suggested Activity
1 also).

Show the different components of an Excel chart.

Familiarize the students with the different types of chart options available.

Demonstrate the steps of:

« Creating a chart (Refer Suggested Activity 2 also).

* Modifying a chart by changing its type, layout and design.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

Q. What are Functions in Excel?

Q. Name the different elements of a formula in Excel.

Q. What is the order of operation followed in Excel?

Q. Define cell referencing.

Q. Name some important categories of Functions.

Q. State the purpose of SUM / SQRT / MOD / COUNT / LEN / RIGHT / TODAY / MAX Function.

Q. What is the syntax of PRODUCT / INT / POWER / CONCATENATE / LEFT / UPPER / LOWER /
MIN / AVERAGE function?

Q. Define charts in Excel.

Q. Whatis alegend?

Q. What are gridlines in a chart?

Q. When s a Line / Column / Pie / Bar / Area chart used?

Q. In Excel, can we change the type of an existing chart?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 28 and
29 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 29 and 30. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 31 will enhance the ability of the
students and serve as a Subject Enrichment activity.

\
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Suggested Activity

1. Askthe students to enter their last mark sheet in Excel and calculate total marks scored, average
marks scored, maximum and minimum marks amongst all the marks and the number of subjects
using various Functions used in Excel.

2. From the previous mark sheets of Grade 1 to 6, collect data about your attendance in various
Grades. Plot a Line Chart in Excel from the data.

3. Moreion Excel

Teaching Objectives
Students will learn about
& Sorting data

@ Filtering data

& Conditional formatting

& Printing a worksheet

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that MS Excel provides easy options for sorting data
and highlighting the required information in a worksheet.

Introduce sorting as arranging the data in ascending or descending order.

Demonstrate to the students the various steps involved in sorting of data in an Excel worksheet.
Share with the concept and use of Custom Sort feature (Refer Suggested Activity 1 also).
Introduce filtering as hiding unwanted data from a set of data.

Show to the students the various steps involved in applying Filters in a worksheet.

Share with the students that Filters once applied can be easily removed and tell them the method
of removing filters.

Introduce Conditional Formatting as highlighting the required information.

Tell the students about basic difference between Filtering (unwanted information gets hidden) and
Conditional Formatting (required information gets highlighted).

Explain the various criteria detailed under Conditional Formatting.

Demonstrate the steps involved in applying conditional formatting on a worksheet (Refer Suggested
Activity 2 also).

Make the students recall that a printout is a hard copy of the information we see on the monitor.
Show to the students the steps involved in the printing of a worksheet.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

Ask the students some oral questions based on this chapter.

Q. Define sorting.

]
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What is the difference between sort and custom sort features?

What are filters?

How can filters be removed in a worksheet?

What do you understand by conditional formatting feature?

How is conditional formatting different from filtering data?

When is the conditional formatting criteria Highlight Cell Rules / Data Bars / Icon Sets used?
What is a printout?

ODOOLOLOLOLL

What are the steps to print a worksheet?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 37 and
38 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 38 and 39. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 39 will enhance the ability of the
students and serve as Subject Enrichment activity.

Suggested Activity

1. Ask the students to enter their height and weight along with similar information for their nine
friends. Sort the data with primary criteria as heights in ascending order and secondary criteria
as weights in descending order.

2. Highlight the cells where the heights are less than the height of the student or weight is more
than the weight of the student preparing the worksheet.

4. Introductionto HTML

Teaching Objectives

Students will learn about

What is HTML?

HTML tags and attributes

Rules for writing HTML codes

HTML document structure

Creating and saving HTML document
Basic HTML tags

Designing a web page

Editing an exiting HTML

§ § 9 9 9 § § §

Teaching Plan Number of periods: 5

While teaching this chapter, tell the students that websites consist of millions of pages called web
pages which contain text, graphics, audios, videos and links to other pages.

\
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Introduce Hypertext Markup Language (HTML) as language that describes the structure of a web page.
Make the students understand the meaning of the terms like hypertext and markup language.

Tell the students about the tools needed for working with HTML.

Make the students aware about the different types of HTML editors - WYSIWYG editor and Text editor.

Familiarise the students with basic HTML terms like tags, container tags, empty tags, block level
tags, text level tags and attributes.

Tell the students about the concept of nesting of tags.
Share with the students the general rules followed for writing HTML codes.

Show to the students a HTML document and make them understand and identify the various sections
and structure of the HTML document.

Demonstrate to the students the steps involved in:
« Creating a HTML document

« Saving a HTML document

« Previewing a web page.

Tell the students about the meaning and use of basic HTML tags covering <HTML>, <HEAD>,
<TITLE> and <BODY> tags alone with their attributes.

Tell the students about some more HTML tags like Heading, Paragraph, Line Break, Horizontal Ruler
(and its attributes), Bold, Italic, Underline, Superscript and Subscript tags.

Share with the students about the use of <FONT> tag and its attributes.

Demonstrate to the students the steps involved in designing a web page using the various HTML
tags discussed.

Show the students the method of editing an existing HTML document.
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is HTML?

Define hypertext and Markup language.

Name the different types of HTML editors.

What are tags and attributes?

State the rules followed while writing HTML codes.

Name the text editor most commonly used to write HTML codes.
State the use of <HTML> / <HEAD> / <BODY> / <TITLE> tags.
What is the difference between container tags and empty tags?
What attributes can be taken by the <FONT> tag?

DOLOLLOLLOLLLLL

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 51 and
52 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 52 and 53. Help the students to solve these questions.
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In Creative Assignment, activities like Fun in Lab given on Page 53 will enhance the ability of the

students and serve as Subject Enrichment activity.

Suggested Activity
Ask the students to develop a similar web page in HTML.

Basics of writing chemical formulas

The valency 1s used to write chemical formulas. The valency is written at the top write corner of the chemical symbol
of the element. For example, valency of Sodum 1s 1 and 1s denoted as:

A chemical reaction is denoted as:

HzO"‘SOz————a}HzSO‘i

5., Introduction/to/Photoshop

Teaching Objectives
Students will learn about

@ Starting Photoshop CS6

< Components of Photoshop CS6

@ Features of Photoshop CS6

@ Creating a new file

@ Saving a file

@ Opening an image for editing

@ Using tools

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that Adobe Photoshop CS6 is powerful graphics software
used for image creation and editing.

Demonstrate to the students the steps to start Adobe Photoshop CS6.

Familiarize the students with the components of Photoshop CS6 covering Menu Bar, Options Bar,
Toolbar, Workspace, Color Panel, Adjustments Panel, Layers Panel and Status Bar.

Share with the students the features of Photoshop CS6.

| —7
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Show to the students the steps involved in creating a new file and the various settings to be made
while creating a file.

Tell the students the process to:

« Save afile.

« Open an image for editing

Show the Photoshop toolbar to the students and share with them the various tools present on it.
Tell the students that Adobe Photoshop CS6 has some tools hidden under a main tool.

Explain to the students the steps involved in the use of:

« Rectangle Marquee Tool — covering Elliptical Marquee Tool, Single Row Marquee Tool and Single
Column Marquee Tool as hidden tools under it.

« Lasso Tool

e Quick Selection Tool
« Crop Tool

¢ Brush Tool

« Eraser Tool

« Rectangle Tool — covering Rounded Rectangle Tool, Ellipse Tool, Polygon Tool and Line Tool as
hidden tools under it.

« Gradient Tool

« Paint Bucket Tool

« Horizontal Type Tool

« Pencil Tool

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.
What is Adobe Photoshop CS6?

Name the various components of Photoshop CS6 interface.
State the features of Adobe Photoshop CS6.

What does RGB and CMYK color modes stand for?

Name some important tools of Photoshop toolbar.

State the use of Rectangular Marquee Tool / Lasso Tool / Crop Tool / Eraser tool / Rectangle
Tool / etc.

What are the different gradient types available in Gradient Tool?

OO OOOLOOLOL

What is the difference between Rectangle Tool and Rectangular Marquee Tool?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 62 and
63 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 63 and 64. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 64 will enhance the ability of the
students and serve as a Subject Enrichment activity.

]

C B
262 } TouchPad Version 1.0-VII (Lesson Plan)

S—

LA



Suggested Activity

Ask the students to draw a similar drawing in Adobe Photoshop CS6 using various tools from the
toolbar.

o {

6., Animations/in/Flash

Teaching Objectives

Students will learn about

& Symbols

& Instances

@ Converting an object into symbol
& Layers

< Frames and keyframes

& Animations in Flash

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that Flash is an authoring tool to create games,
applications, simple animations, etc.

Introduce the concept of Symbols in Flash CS6.

Tell the students about different types of symbols — graphic, button and movie clip — and explain
their uses.

Show to the students the various steps involved in creating a symbol.

Introduce the meaning of the term Instances and the situation where they are used.
Demonstrate the steps involved in converting an object into symbol.

Tell the students about Layers and their importance in Flash.

TouchPad Version 1.0-VII (Lesson Plan) ¢ 63,



Make the students understand the meaning of and difference between frames and keyframes.
Explain the concept of animation using tweens.

Show the steps to create various types of tweens covering Shape Tween and Motion Tween.
Tell the students that animation can also be done in Flash through Frame by Frame technique.
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is Adobe Flash used for?

What is the meaning of Symbols?

Name the different types of Symbols available in Flash.

Define instances.

What do you understand by Layers?

How are layers useful?

What is the difference between a frame and a keyframe?

Define Tween.

What is the meaning of easing?

DOOLOLOLOLOLDO

What is Motion Guide Tweening?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 75 and
76 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 76 and 77. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 77 will enhance the ability of the
students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to create an animation where two cars are coming on a road from opposite directions
and crash in the center.

7. Internet'and E-mail

Teaching Objectives
Students will learn about
& The Internet

World Wide Web
How the web works?
Using web browser
Using URLs

§ 8§ 9 9
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& E-mail
@ Emoticons, Acronyms and Netiquettes

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that the internet is a computer network that connects
hosts and end systems throughout the world.

Give a brief history of the beginning of internet as ARPANET.

Introduce the concept of World Wide Web (WWW) with reference to basic terms covering web, web
servers, posting/uploading, etc.

Explain to the students the process of how the web works.
Introduce web browser as software application designed to find hypertext documents on the web.
Show to the students the steps involved in the process of launching the web browser.

Tell the students about Uniform Resource Locator or URL (unique internet address) and their use
while navigating on internet.

Make the students recall E-mail as the process of exchanging messages electronically through
communications network by using a computer.

Share with the students the advantages and disadvantages of e-mail.

Explain the components of an e-mail address to the students.

Demonstrate in detail the steps involved in:

« Creating an e-mail account

* Signing in to an e-mail account

» Sending an e-mail (with reference to fields like To, Cc, Bcc and Subject)

« Attaching files to an e-mail

» Reading a received e-mail

+ Signing out from the e-mail account (tell them the importance of this step)

Introduce the terms emoticons (representation of facial expressions), acronyms (word formed
from initial letters of a multi-word name) and netiquettes (set of rules to be followed for internet
communication).

Write some commonly used emoticons and acronyms on the class board to elaborate the concept.
Ensure that the scope of Teacher’s Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is World Wide Web?

Define web server.

How the web works?

Expand URL.

Define an e-mail.

What do you understand by emoticons?

What is an acronym?

What are netiquettes?

State any three netiquettes.

DOOLLOLOLOLOLOOL

\

A 3
TouchPad Version 1.0-VII (Lesson Plan) / 65

I

-



Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 88 and
89 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Page 90. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 90 will enhance the ability of the
students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to create an e-mail account. Tell them to design a birthday invitation card in Adobe
Photoshop and send this card as an attachment to ten friends and/or relatives.

8. (computer/Safetyand/Secutiry

Teaching Objectives

Students will learn about

How to keep your computer physically fit?
Protecting your computer from illegal access
How to backup your important files?

Other maintenance techniques

Malware

Antivirus

9 § 9 9 § § 9§

Firewall

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that computer safety refers to the protection of
computer-based resources against unauthorized use or physical damage.

Tell the students the method of physically cleaning computer parts like keyboard, mouse and monitor.

Share with the students the method to protect the computer from illegal access by reference to

terms like authentication (verifying user's identity) and covering:

« Password protection

+ Biometric authentication including face recognition, iris biometrics, retina biometrics and voice
recognition

« Encryption (converting data into cypher text)

Explain the need, importance and process of backing up important files using external hard disk

drives and online backup services.

Share with the students some information about some other maintenance techniques like deleting
files, defragmenting hard disk drive and disk cleanup.

]
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Introduce malware as programs designed to damage or carry out unwanted actions on a computer
system.

Explain to the students information about different types of malware like virus, worms, Trojan horses,
spyware, zombie, ransomware, rootkits and backdoors.

Explain the importance of antivirus and firewall in maintain computer safety and security.
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

Q. Define authentication.

Q. Where is elastic graph matching technique used?

Q. What is the difference between encryption and decryption?
Q. What is malware?

Q. Define virus / worm / rootkit / backdoor / ransomware.

Q. What is an anti-virus?

Q. Name some commonly used anti-virus software.
Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 99 and
100 as One Touch Learn and Let's Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Pages 100 and 101. Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 101 will enhance the ability of the
students and serve as a Subject Enrichment activity.

Suggested Activity
Ask the students to prepare a detailed project on any anti-virus software on an A3 sheet.

9., Programming'with/Python

Teaching Objectives
Students will learn about

& Features of Python & How to use Python IDLE

@ Basic commands of IDLE @ Variables in Python

@ Character set & Keywords

& Data types @ Operators

@ Comments in Python @ The input() statement

@ The print() statement @ Creating simple Python programs

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students about Python as a high level programming language
and its uses.

\
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Share with the students the important features of Python.
Demonstrate the steps to start Python IDLE.
Familiarize the students with the interface of Python IDLE.

Tell the students the basic commands of IDLE like creating a new file, saving a file, opening an existing
file, executing a programming file, closing a file and exiting IDLE.

Introduce variables as memory location used to store data.
Share with the students the rules of naming variable in Python.

Tell the students about important terms like character set, keywords and data types (covering number,
string, list, tuple, dictionary and none).

Explain the operators used in Python stating the common arithmetic operators (+, -, *, /, //, %, **),
relational operators (= =, !=, >, <, >=, <=) and logical operators (&, |).

Demonstrate to the students the use of these operators and commands in simple Python programs.
Explain the use and importance of comments in Python.

Tell the students the purpose and syntax of:

¢ The input() statement

¢ The print() statement

Encourage the students to write simple programs in Python.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

Ask the students some oral questions based on this chapter.

Q. What is Python?

Q. Expand IDLE.

Q. What is the use of arithmetic / logical / relational operators?
Q. Define keywords / variables / data types.

Q. What is the use of input() / print() statement?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 112 and
113 as One Touch Learn and Let’s Do It. After solving the course book exercises, tell the students to
solve Crack the Code activity given on Page 114. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 115 will enhance the
ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to develop programs in Python to calculate:
*  Volume of cube

*  Volume of cuboid

e Radius of circle when the area of the circle is given

]
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ANSWER KEY

1. INumber System

One Touch Learn o

A.
B.
C.

LA sl el o

(c) 2. (a) 3. (0 4. (a)

T 2. T 3.7 4. T 5T
0 2. 2 3. decimal number 4. 10
8 6. binary

oo

A.

1.
2.
3.
1

Octal number system is used as a shorthand representation of long binary numbers.
Group of 8 binary digits either 0 or 1 is called a byte.
Base in octal number system is 8 and hexadecimal number system is 16.

A number system is simply a method of counting. There are 4 types of number systems in
computer such as binary number system, decimal number system, octal number system,
and hexadecimal number system.

To convert a decimal number into a binary number:
Step 1 Divide the decimal number by 2 (the base of the binary number system).
Step 2 Note down the quotient and the remainder.

Step 3 Divide the quotient obtained again by 2 and note down the resulting quotient
and remainder.

Step 4 Repeat the procedure till you reach a quotient less than 2.

Step 5 List the last quotient and all the remainders (moving from bottom to top). You
have your binary number.

The rules to multiply two binary numbers are:

X Y XxY

0 0 0x0=0
0 1 0x1=0
1 0 1x0=0
1 1 1x1=1

|
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C. 1 (10111011), = 1x2°+0x 2 +1x22+1x20+1x20+0x2+1x2?+1x23
= 1x16+0+1x4+1x2+1x1+0+1/4+1/8
= 16+4+2+1+025+0.125
= (23.375),

2 @ @ Borrow
1 0 O 1 1 0
- 1 1 o0 1
1 1 0 0 1
@ @ @ Carry
3. (a) 1 O 0O o0 (b) : 0 : :
+ 1 0 1 n o a1
1 1 0 1 ] T 0 o o
@ Carry @ @ @ Carry
(C) b (d) 11 1
- Lol + 1 1 1 1
1 1T 1 0 T T
@ Carry

—_
o
-
—_
—_
o

- 2 |94 (b) 2 | 72
2 [19-1 153
2] 9 2 [18-0
2] 4 2| 9-0
2] 20 2| 4-1
| 1-o0 15
| 1-0

Hence, (39),,= (100111)
10 > Hence, (72),, = (1001000),
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© 2 | 128 d) 2 |55
2| 64-0 2 [ 27-1
2| 32-0 2 [13-1
2 | 16-0 2| 6-1
2| s8-o0 2| 3-0
2| 4-0 ] 1-1
2|1 2-0 Hence, (55),, = (110111),
1-0

Hence, (128),, = (10000000),

e) 173

0]

(o)
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o
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|
o

Hence, (173),, = (10101101),
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2., [Formulas}, Functions/and Charts in 'Excel

One Touch Learn )

w >

o0

o

(a) 2. (a) 3. (o) 4. (b) 5. (b)
T 2. T 3.7
F Correct Statement: We can create Bar chart in MS Excel.
T
Functions 2. equals 3. squareroot 4. column 5. Dollar ($)
b 2. ¢ 3. d 4. a
@

Lets Do It

A.

]

1
2.

A cell or a range of cells that you want to use in your calculation is called cell reference.
a. Data series is related to the set of values. It is represented by the bars or slices that
represent the data values.
b. Legend is a key which shows the meanings of symbols and colours used in the chart.
A formula is an expression which calculates the value of a cell. Formulas in Microsoft Excel
begin with an equal sign. For example,
=10+ 20/5 + (5*4)
=20+ 60*10
Excel follows certain rules of precedence:
(i) Excel calculates expressions within parentheses ‘(" , ) first.
(i) Excel calculates multiplication and division before addition and subtraction.
(iii) Excel calculates consecutive operators with the same level of precedence from left
to right.
The LEN function returns the length of the text string. For example,
=LEN("Excel”) will return 5.
Rules for using functions are:
(i) All Excel functions must begin with = sign.
(i) Function name must be a valid Excel name.
(iii) Function must be followed by opening and closing parenthesis.
(iv) Functions must contain an argument within it.

The Column chart is used to show the changes in data over a period of time or comparison
among the different data items and Scatter chart is used to show the correlations between
the two sets of values.
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A. 1. PieChart
2. Cell Referencing
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3. Moreon Excel

One Touch Learn )

A. 1 (a 2. (0 3. (0 4. (o
B. 1. F Correct Statement: Excel can arrange data in ascending or descending order.

2. F Correct Statement: You can sort more than one columns at a time in a selected range
of cells.
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C.

Let's Do
A.

3. F Correct Statement: The Add Level button is available in the Sort dialog box.
4. T
1. customsort 2. styles 3. conditional formatting 4. filters

@

it 9

1. Excel can arrange the selected data in ascending or descending order. This is called sorting
of data.

Filters can be removed by clicking anywhere in the worksheet and repeating steps to apply

2.

filters.
For arr

. Touse

anging a data in the sequential order, we need to sort the data.
Custom Sort:

Step 1 Select the range of columns to be sorted.
Step 2 Click Sort & Filter command from Editing group under Home tab.

Step 3

Click on Custom Sort option.

Step 4 Check My data has headers checkbox if the selected columns have a heading at

the top.

Step 5 Click the Sort by box to open list of column headers. Select the desired column

head for sorting.

Step 6 Click Sort On box to select Values option.
Step 7 Click Order box and select the desired option.
Step 8 Click on Add Level button on the top of the dialog box. This will add one more row

to define new criteria.

Step 9 Repeat steps 5 to 7 to sort another column.
Step 10 Click on OK button.

Sorting data means to arrange the data in ascending or descending order. On the other
hand, filtering data means to filter unwanted data from a set of data.

Names of criteria are:

(i)
(ii)
(i)
(iv)
v)

Highlight Cells Rules
Top/Bottom Rules
Data Bars

Color Scales

Icon Sets

Crack The Code
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1. By sorting the data of sales column in descending order.
2. Conditional Formatting
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Periodic Assessment=1
(Based on chapters 1 to 3)

The total number of digits used in a number system is called its base.
Hexadecimal number system consists of 16 digits from 0-9 and A to F.
In BEDMAS rule, E stands for exponentiation.

$ sign can be used in both absolute referencing and mixed referencing.
Conditional Formatting command is present under Home tab.

It is used to show the changes in data over a period of time.

It is used to show the relative size of each value.

It is used to display the quantitative magnitude of the data graphically.
It is used to display the data in the form of long rectangular rods also called bars.
It is used to show the correlations between the two sets of values.
Scientific 2. H 3. Particular 4. Average

C 2. e 3. b 4. a 5.d
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4. Introductionto HTML

e

One Touch Learn )

w >

n

1
1
2.
3
1

. (a) 2. (0 3. (d) 4. (d)

F Correct Statement: The container tags have both opening and closing tags.
F Correct Statement: The main content of a web page are marked by the <BODY> tag.

T 4. T

markup 2. <head> 3. <b> 4. <p>
K

Lets Do It <

A. 1.

2.

w

B. 1

HTML stands for Hyper Text Markup Language. It is the most widely used markup language
to design web pages.

(i) Empty tag
(ii) Container tags

(i) Hypertextis a piece of ordinary text that has special feature of linking to other documents
or web pages.

(i) Markup language is a language that uses special symbols called Tags to mark up a text
document that instructs the browser how to display the text.

The <HTML> tag tells the web browser that the text contained between <HTML> and
</HTML> is a web page and can be viewed using a web browser. The <BODY> tag tells
the web browser that the text contained between <BODY> and </BODY> tags is to be
shown on the web page.

Rules for writing HTML tags are:
(i) Container tags should always be closed properly.
(i) Values given to the attributes should be enclosed within the double quotes.
(iii) Tag name should not contain spaces.
(iv) There should be no spaces between < and > in a tag.
(v) Tags must be nested correctly.

The Line Break tag is written as <BR>. This tag is used when you want to start a new line,
but do not want to start a new paragraph. On the other hand, the Horizontal ruler tag is
written as <HR>. This tag is used when you want to divide your web page into different
sections.

Crack The Code

A. 1.
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<HR> 2. <U> 3. <BR> 4. <HTML> 5. <BODY>
<H1>
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5., Introduction/to/Photoshop

One Touch Learn )

A. 1 (b 2. (a) 3. (0 4. (a)
B. 1T
2. Correct Statement: There are three types of Lasso tools.
3. Correct Statement: You can draw geometrical shapes, create and edit digital images
in Photoshop.
4. F Correct Statement: There are various types of selection tools in Photoshop.
5 T
C. 1. pencil 2. workspace 3. lasso 4. Horizontal Type 5. gradient
oo’
A. 1. Rectangular Marquee Tool is used to select a rectangular portion of an image.
2. Lasso Tool is used to make freehand selection in the images.
3. RGB stands for Red Green Blue. CMYK stands for Cyan Magenta Yellow Black.
4. Brush Tool is used to draw brush strokes to give an effect of painting to the image and

Paint Bucket Tool is used to fill the colour in closed shapes and images.

| —7
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B. 1. Adobe Photoshop is a graphics software developed and published by Adobe Inc. Features
of Photoshop are:

User friendly interface
Photo manipulation can be done in less time

Powerful tools are used to change the color of an image by adjusting brightness,
contrast, color balance, hue and saturation levels

Create graphics for web applications with reduced file size, thus helping in faster loading
of the websites

Layer effect preserves the original state of the image
Can be used to create 3-D icons

2. There are various types of painting tools in Photoshop. Some of them are:

Pencil Tool: It is used to draw freehand shapes.

Brush Tool: It is used to draw brush strokes to give an effect of painting to the image.
Eraser Tool: It is used to erase or rub some portion of an image or workspace.
Paint Bucket Tool: It is used to fill the colour in closed shapes.

3. Rectangular Marquee Tool is used to select a rectangular portion of an image and Elliptical
Marquee Tool is used to select an oval or circular portion of an image.

Crack The Code %}

A. 1. Quick Selection Tool
2. Brush Tool
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Periodic Assessment-2

(Based on chapters 4 & 5)
<P> 2. <BR> 3. <HR> 4. <TITLE>
Line Tool 2. Gradient Tool
Rectangle Tool 4. Lasso Tool
Test Sheet-1
(Based on chapters 1 to 5)
Section A
(c) 2. (0) 3. (o) 4. (a)
(a) 6. (a) 7. (b) 8. (b
radix 2. Doller$ 3. Editing 4. TEXT 5. Lasso Tool
T 2. T
F Correct Statement: Add Level button is available under the Sort dialog box.
T
F Correct Statement: There are three different types of Lasso Tool.
C 2. a 3. d 4. e 5 b
Section B

The base of octal number system is 8 and hexadecimal number system is 16.

A cell or a range of cells that you want to use in your calculation is called cell reference.
For arranging a data in the sequential order, we need to sort the data.

Empty tags and Container tags.

Marquee tools are used to select a portion of the image.

To convert a decimal number into a binary number:

Step 1 Divide the decimal number by 2 (the base of the binary number system).

A .
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Step 2 Note down the quotient and the remainder.

Step 3

Divide the quotient obtained again by 2 and note down the resulting quotient and
remainder.

Step 4 Repeat the procedure till you reach a quotient less than 2.

Step 5 List the last quotient and all the remainders (moving from bottom to top). You have

your binary number.

Excel follows certain rules of precedence:

(i)
(ii)
(iii)

To use

Excel calculates expressions within parentheses (", ')’ first.

Excel calculates multiplication and division before addition and subtraction.

Excel calculates consecutive operators with the same level of precedence from left
to right.

Custom Sort:

Step 1 Select the range of columns to be sorted.
Step 2 Click Sort & Filter command from Editing group under Home tab.

Step 3

Click on Custom Sort option.

Step 4 Check My data has headers checkbox if the selected columns have a heading at

Step 5

the top.
Click the Sort by box to open list of column headers. Select the desired column
head for sorting.

Step 6 Click Sort On box to select Values option.
Step 7 Click Order box and select the desired option.
Step 8 Click on Add Level button on the top of the dialog box. This will add one more row

to define new criteria.

Step 9 Repeat steps 5 to 7 to sort another column.

Step 10 Click on OK button.

To apply cell border:

Step 1 Select the cells on which you want to apply the cell border.

Step 2 Click on Border command from the Font group under the Home tab.
Step 3 Click on appropriate option from the drop-down menu.

6. Animations in/Flash

One Touch Learn )

A. 1

B. 1.
3
4.

cC. 1

]

(a)
T

2. (0 3. (0 4. (0
2. T

F Correct Statement: Animation arranges the view of the layers associated with it.

F Correct Statement: An instance is a copy of a symbol, which is dragged from the library
to the stage.

. symbol 2. alpha 3. frame 4. tween
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A. 1. The movie clip symbol is a type of symbol which contains another Flash movie within a
Flash movie.

2. Layers are thin pieces of transparent sheets.

3. Akeyframe is a frame where major changes take place in an animation.
4. Timeline is a panel in Flash that contains layers and frames.
1

Symbol is a reusable object in Flash and an instance is the copy of the original symbol. You
can create many instances of a symbol.

Each of the button symbols has four different stages such as Up, Over, Down, and Hit. The
functions of these four different states are:

(i) The Up state is the state when the mouse pointer is not over the button.
(i) The Over state is the state when the mouse pointer is moved over the button.
(i) The Down state is the state when the button is clicked.
(iv) The Hit state is the state which will define the response of the user’'s mouse action.

3. Atweenis atype of animation in Flash. In tween, you need to create the starting and ending
keyframes to animate the object. There are two types of tweens in Flash that are shape
tween and motion tween.

Crack The Code

A. 1. Blank Keyframe
2. Tween animation

N

B. 1. Layer2 2. layerl 3. Layerl 4. Shape Tween
[ ]
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7. Internet'and E-mail

One Touch Learn )

A. 1 (o 2. (a) 3. (0 4. (a) 5. (0)
B. 1. F Correct Statement: Gmail allows you to send an e-mail.

Correct Statement: Carbon copy is used to specify the addresses of all the recipients
who will also receive copies of the same e-mail.

3. F Correct Statement: The e-mail address is different for every Internet user.
4. F Correct Statement: CC stands for carbon copy.
C. 1. Bcc 2. To 3. Cc 4. Attachment 5. Website

Jam/
.
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Lets Do It &
A. 1. TheInternet is a computer network that connects hosts and end systems throughout the
world.
2. HTTP stands for Hypertext Transfer Protocol. It is a protocol used on Web.
3. URL stands for Uniform Resource Locator. It is an address of a web page over the Internet.
4. An Electronic mail or e-mail can be defined as the system of exchanging messages
electronically through a communications network by using computer.

B. 1. The World Wide Web (WWW) is a large information system where you can surf and get
information. WWW is also known as Web. It is differ from Internet as the Internet is a
computer network that connects hosts and end systems throughout the world.

2. Advantages of e-mail are:

(i)
(ii)
(iii)
(iv)
v)
(vi)

An e-mail can be sent anytime and from anywhere in the world.

An e-mail can be sent to many people at a time.

An e-mail can be easily forwarded to anyone without typing it again.

Sending an e-mail is fast in comparison to traditional mails.

Music, images or any other computer file can be shared with anyone by using e-mail.

If an e-mail is not delivered, you receive an e-mail explaining the problem why the
e-mail could not be delivered.

3. Forsigning in to your Gmail account:
Step 1 Double-click on the Web browser icon.
Step 2 Type www.gmail.com in the address bar of the browser window and press Enter

]

key.

Step 3 Click on Sign in button on the top right-hand of the browser window.
Step 4 In the Email or phone field, enter username of the email address that you have

created.

Step 5 Click on Next button.
Step 6 In the Password field, enter the password you had created for your email account

and click on Next button.

For signing out to your Gmail account:
Step 1 Click on the icon on the top right corner of your browser window.
Step 2 Click on Sign out button.

Crack The Code %

A. 1. Attachmentin an e-mail

2. Sushant should write the e-mail address of Ajay in the To field and e-mail addresses of
others in the Cc field.

3. After sending e-mail to his boss, Raman should sign out from his e-mail account.
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4.
C. L
6.

e o

Periodic/Assessment-3
(Based on chapters 6 & 7)

Show or Hide All Layers
Blank Keyframe

Attach files

Lock or Unlock All Layers

To: In this field, type your friend's e-mail address. You can enter more than one address
by pressing ', after each e-mail address.

Cc: Cc stands for carbon copy. It is marked to the e-mail address who is to be informed
that an e-mail has been sent to the person marked in To field.

Bcc: Bcc stands for blind carbon copy. It is marked to the e-mail address when you do not
want others to see to whom the e-mail has been sent.

Subject: In this field, a one line introduction about the purpose of the e-mail is mentioned.
Happy 2. Crying 3. Angry 4. Tired 5. Fine
See You Later 7. By The Way 8. As Soon As Possible

D. Four netiquettes are:

(i) The subject of email must be in relation to the matter of the email.

(i)

Signatures in an email should be small and simple.

(iii) Avoid sending repeated mails just for publicity of the product or service.
(iv) Avoid typing in capital letters as typing in capitals is taken as shouting at the person.

E. 1.

Ctrl + L 2. F8 3. Ctrl + Enter 4. F7

\
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8. (Computer/Safetyand Secutiry

One Touch Learn )

A. 1 (b 2. (0 3. (a) 4. (o)
B. 1. F Correct Statement: Encrypted data cannot be understood easily.
2. T 3.7 4. T
C. 1. malware 2. biometric 3. decryption 4. encryption 5. zombie
@

Lets Do It ©

A. 1. Authentication is the process of verifying a user’'s identity before granting him or her access
to a computer system. Some of the authentication types are:

(i) Password Authentication
(i) Biometric Authentication

Trojan or Trojan horse is a type of malware program. The purpose of the trojan horse is to
conceal itself inside the software that seems legitimate.

3. Anantivirus program is a software which can detect the presence of a virus on a computer
and remove the virus.

1. Dust can potentially destroy the parts of your computer. By cleaning your computer regularly,
you can maintain its performance and avoid expenses on repairs. Cleaning the computer
means cleaning different parts of the computer system like keyboard, mouse and monitor.

2. Malware is a malicious software. It is designed to damage or carryout other unwanted
actions on a computer system. The different types of malware are virus, worm, trojan horse,
spyware, zombies, ramsomware, rootkit and backdoor.

The biggest difference between a worm and a virus is that worms are aware if the system
is connected to a network. A virus finds it very easy to replicate itself amongst files on the
same computer, however, it has a hard time jumping from one computer to another. A
worm overcomes this computer-to-computer hurdle by seeking new hosts on the network
and attempting to infect them.

Crack The Code

A. 1. Spyware 2. Trojan horse 3. Zombie 4. Ransomware
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9., Programming'with/Python

One Touch Learn )

One Touch Learn N2

® >

n

o

1
1
4.
5
1

bl

(d) 2. (o) 3. (b) 4. (a) 5. ()

T 2.7 3. T

F Correct Statement: IDLE stands for Integrated Development and Learning Environment.
T

object-oriented programming 2. reserved 3. operators
print() 5. input()
d 2. a 3. b 4. ¢

@

Let's Do It <

A.

1

Python is a powerful, high-level, general purpose, interpreted, interactive, multi-platform,
and object-oriented programming language.

The % operator returns the remainder. For example, 11%4 returns 3 as remainder.

The ** operator raises the first operand to the power of the second and returns the result.
For example, 11**4 returns 14641.

A character set means the characters like alphabet, digits or special symbols that can be
used to write programs in Python language.

Four features of Python are:

(i) Easy to learn: Python has relatively few keywords, simple structure and a clearly
defined syntax.

A
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(i)
(iii)

(iv)

Easy to read: Python code is just like English language.

Case Sensitive: Python is case sensitive language. In Python, ‘pay’ and ‘PAY" are not
the same. They are interpreted differently.
Free and Open source: Python is an example of open source software. It means you

can freely distribute copies of this software, read its source code and make changes
to it.

2. Variables are memory locations that are used to store values. Rules for defining a variable

are:
0]
(ii)
(iif)
(iv)
v)

(vi)
(vii)

A variable name must start with a letter (a—z, A-Z) or an underscore ().
A variable name cannot start with a digit.
Keywords cannot be used as variable names.

A variable can only contain alpha-numeric characters and underscore (A-Z both
capital as well as small) and (0 — 9) numbers.

No special symbols like !, @, #, $, %, etc. can be used in variable name.
Variable names are case sensitive.
Variable names can be of any length.

3. The input( ) statement is used to take input from the user during the execution of the
program. The input statement acts as a message communicator between user and the
computer. For example,

1
2.

1
5.
1
3.

X = input ("What is your name?")

In this example, the input statement uses the prompt “What is your name?” to get the input
from user and assigns it to the variable X.

@
Crack The Code %

By using arithmetic operator
The input() and print() statements
Python 2. IDLE 3. Variable 4. Keyword

List
Error

6. Comment 7. print()
2. Error

101025

False
5.0
50

10000000000
Python

* P = int(input("Enter principle amount: "))
r = int(input("Enter rate of interest: "))

t = int(input("Enter time duration in years: “))

]
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SI = (P*r*t)/100
print(“"Simple interest is: “,SI)

X bsalary = int(input("Enter basic salary: "))
incentive = bsalary * 7/100

netsalary =

bsalary + incentive

print(“Net salary is: “,netsalary)

o]
wnN R AR

Periodic/ Assessment=4
(Based on chapters 8 & 9)

Authentication 2. Antivirus 3. Rootkit

Character Set 5. List

Variables are memory locations that are used to store values.

Keywords are the reserved words which cannot be used as variable names.

The input( ) statement is used to take input from the user during the execution of the

program.
4. The print() statement is used to print the output of a program on the screen.

n

YOU

HAVE DECIPHERED CORRECTLY

D. 1. Names of five malware programs are:

(i)
(i)
(i)
(iv)
(v)

Virus

Worm
Trojan horse
Rootkit
Spyware

2. Variables are memory locations that are used to store values. Rules for defining a variable

are:
(i)
(i)
(iif)
(iv)
v)

(vi)
(vii)

A variable name must start with a letter (a—z, A-Z) or an underscore ().
A variable name cannot start with a digit.
Keywords cannot be used as variable names.

A variable can only contain alpha-numeric characters and underscore (A-Z both
capital as well as small) and (0 — 9) numbers.

No special symbols like !, @, #, $, %, etc. can be used in variable name.
Variable names are case sensitive.
Variable names can be of any length.

Arithmetic operators are used to do basic mathematical calculations.
F. 1. radius = float(input(“Enter radius of circle: “))
pi = 3.14
area = pi * radius * radius

circumference = 2 * pi * radius
print(“Area of circle is:",area)

print(“"Circumference of circle is:", circumference)

\
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print(”* * * * * * * E * 'k")

print("* *)
print("* *)
print("* *)
print("* *)
print("* *)
print("* )
print("* *)
print("* )
print("* *)
print("* *)

print("* * * * * * * * % * *")

Test Sheet-2

(Based on chapters 6 to 9)

Section A
(a, b, 0 2. (a) 3. (a) 4. (a) 5. ()
(0 7. (a) 8. (0
# 2. backgrounds 3. frame
movie clip 5. Authentication
Section B

Adobe Flash Professional CS6 is an authoring tool to create games, applications, simple
animations, etc.

We use button symbols to add interactivity to the movie.
Rootkit is a malware that gains administrator access to the host system.
The Run — Run Module command is used to run the Python program.

An antivirus program is a software which can detect the presence of a virus on a computer
and remove the virus.

E-mail stands for electronic mail.

Animation involves a series of still images which are usually sketched or painted and
displayed in a rapid sequence. This transition from one image to another is so quick
that it appears to be moving. Animation in Flash is created by changing the contents
of the successive frames.

Computer viruses are similar to their biological counterparts because they are capable
of self-replication. The prime motive of a virus is not to cause damage, but to clone
itself onto another host so that it can spread further. If a virus causes damage it is more
likely to be detected, and for this reason virus authors employ stealth techniques to
keep it unnoticed.

£ ,
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3. The World Wide Web (WWW) is a large information system where you can surf and get
information. It consists of several public and private websites which may be interlinked and
accessible over the Internet worldwide. WWW is also known as Web.

4. Biometric authentication is a process in which biological characteristics such as finger print,
face, and retina are used to check the identity of an individual. In this process, a biometric
machine is used to capture the biological details of a person and compare these details
with the existing details, which are stored in computer.

5. a. Avariable is a memory location that is used to store a value. When a variable is created,
some space is allocated in memory for it.

b. An operator is special symbol in Python that is used to perform arithmetic or logical
computation.

CS_Marks = int(input(“Enter marks of Computer Science: “))
English_Marks = int(input(“Enter marks of English: “))
Science_Marks = int(input("Enter marks of Science: "))

Total = CS_Marks + English_Marks + Science_Marks
Average = Total/3

print(“Total marks:”, Total)

print(“"Average marks:”, Average)

\

v 3
TouchPad Version 1.0-VII (Answer Key) / 89

I

-



(192ysiiom 21284d) ||A-Q° L UOISISA AYVdHONOL

PRACTICE| WORKSHEE(T

1. INumber/System

A.

Tick (v') the correct option.

1. The total number of digits used in a number system is called its
a. Exponentiation b. Power ¢.  Radix d. Expansion
2. The Most Significant Digit is the digit of a number.
a. Leftmost b. Rightmost c. Center d. Highest
3. The letter F in hexadecimal number system represents in the decimal number
system.
a. 2 b. 10 c. 15 d. 16
4. Base 2 is another name for the number system.
a. Binary b. Decimal ¢. Hexadecimal d. Fractional
Who am I?
1. Tam a method in which value of a number is determined by multiplying the
digits with the weight of their position and adding the results.
2. Tam asingle binary digit.
3. Irepresent the ON state of an electronic component.
4. Tam a group of four binary digits.

State whether the given statements are True or False. Correct the false statements.

1
2.
3.
4.

If the last digit of a binary number is 1, the number is even.

To convert a binary number into a decimal number, start from the LSD.
Computers use binary digits.

Computer system understands hexadecimal numbers.

Answer these questions.

1

2.
3.
4.

What is a byte?

What are the rules to convert a decimal number into a binary number?
Write the rules to add two binary numbers.

Convert (1000),, into its binary equivalent.

Note: More Worksheets are available online. Visit www.thetouchpad.com
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2. Formulas) Functions/and Charts in Excel

A. Tick (v) the correct option.

1 option is used while pasting formulas.
a. Paste b. Paste Formulas
c. Paste Special d. Paste All
2. Press key repeatedly over a reference to switch between making rows or
columns absolute.
a. F2 b. F4
c. F6 d. F8
3. cell reference can be included in absolute reference.
a. $K$13 b. $K13
K$13 d. K13
4. The key combination used to get the sum of adjacent cells is
a. MOD() b. Ctrl +S
c. Alt+ = d. None of these

B. State the purpose, sample input and output for these Excel functions.
1. MOD 2. POWER 3. COUNT
4. LEN 5. LOWER

C. State whether the given statements are True or False. Correct the false statements.

1. Constants are the numbers or text values that do not change.

2. Logical functions calculate maximum, minimum, average, etc.

3. Excel calculates expressions with parenthesis first.

4. Excel calculates consecutive operators with the same level of precedence

from right to left.
5. The SQRT() function returns the square of the given number.

D. Answer these questions.

1. What rule is followed by Excel for doing mathematical calculations?
What is plot area of a chart?
What is cell reference?
What is the use of the CONCATENATE function? Explain with example.
Differentiate between Column chart and Scatter chart.

vk wnN

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

3. Moreion Excel

A. Tick (v) the correct option.

1. Arranging the data in ascending or descending order is called in Excel.
a. Rearranging b. Ordering
c. Sorting d. All of these
2. is selected when you want to highlight all cells satisfying a given condition.
a. Highlight Cells Rules b. Top/Bottom Rules
c. Data Bars d. Colour Scales
3. Sort & Filter command is present under tab.
a. Home b. Formula
c. Insert d. View
4. We use Smallest to Largest option to sort

a. Numbers b. Symbols
c. Text d. All of these

B. Name the tool/command and state its use in Excel.

1

5.

| Add Level 2.
 d a

el
=

1144
YH

C. State whether the given statements are True or False. Correct the false statements.

Hw N

The filters once applied cannot be removed.

New Rule option is used to define own rule for conditional formatting.
The shortcut to open Print dialog box is Ctrl + R keys.

The Add Level button is available under Insert tab.

Filters are used to separate required data from a set of data.

D. Answer these questions.

1

vk W

Define conditional formatting in Excel.

When is Custom Sort used?

Why do we need to sort data?

Write the steps to sort data in Excel.

What is the difference between sorting data and filtering data?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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4. Introductionto HTML

A. Tick (v) the correct option.

1.

2.

is not a text editor.

a. Notepad b. Wordpad c. Amaya d. All of these
A HTML file is saved with extension.
a. .htm b. .txt c. .doc d. .web

is a container tag.
a. <FONT> b. <BODY> c. <BR> d. <HR>

tag enables you to apply the style on a single character, word or group

of words.
a. <CENTER> b. <HR> c. <BODY> d. <B>

B. Name the tag/attribute explained in these statements.

1.

4,
5.

C. State whether the given statements are True or False. Correct the false statements.
1.

2
3.
4,
5. The page title is located inside the <BODY> tag.

Tells the web browser that the text contained within is a web page and
can be viewed using a web browser.

Defines a colour to the background of the web page.

Tells the web browser that the text contained within does not form part
of the web page.

Used to give italics effect to the text.
Used to define the font family.

The tags do not appear in the browser window but they effect the display
of the text and non-text items in it.

. Values given to the attributes should be enclosed in the angle brackets.

LEFT is an attribute of <P> tag.
The container tags have only the opening tag.

D. Answer these questions.

1

A

What is HTML?

What do you mean by nesting of tags?

Write a short note on WYSIWYG.

Write the steps to edit a HTML document.

Explain the purpose of <HTML> and <BODY> tags.

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

5.

A.

D.

Introductioni'to Photoshop

Tick (v) the correct option.

1 displays zoom level of workspace.
a. Title bar b. Tool bar
c. Options bar d. Status bar
2. Low number of indicates transparency.
a. Transparent b. Opacity
c. Translucency d. None of these
3. drop-down list is used to give Bold, Italic, Underline, etc. to the text.
a. Fontsize b. Font family
c. Fontstyle d. Font
4. The default extension of Adobe Photoshop file is
a. .psd b. .phd
c. .pcd d. .pdd

Identify the Photoshop tool from the icon and state its use.

1. k=3 2.

5

State whether the given statements are True or False. Correct the false statements.
1. Adobe Photoshop was first developed by Thomas Knoll.

2. The Options Bar contains different menus.

3. RGB color mode defines colours in terms of Red, Green and Black.

4

. Angle Gradient is used when conical shapes are to be shown in the
Gradient effect.

5. There are four different types of Lasso tools.

Answer these questions.

1. What is the use of Rectangular Marquee tool?

What is the use of Stroke feature in Photoshop?

How Brush Tool is different from Paint Bucket Tool?

What are the various steps involved in opening an image for editing?
What is Adobe Photoshop? Describe its features.

vk Wi

Note: More Worksheets are available online. Visit www.thetouchpad.com
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6. Animations in/Flash

A. Tick (v) the correct option.

1

The symbols add interactivity to the movie.
a. Graphic b. Button
c. Movie d. Clip
2. Ablank keyframe is represented by a below the frame number in the timeline.
a. Hollow circle b. Filled circle
c. Triangle d. Square

4,

tween does not show the sequence of the change from one object to another.

a. Shape b. Motion
c. Frame by Frame d. None of these
The panel that stores the symbols created by Flash is
a. Color b. Library

c. Text d. Mask

B. State the shortcut keys to perform these tasks in Flash CS6.

A wnN e

C. State whether the given statements are True or False. Correct the false statements.
1.

To open the Flash Library.

To convert an object to a symbol.
To insert a frame.

To insert a blank keyframe.

To insert a keyframe.

Keyframes are those frames where major changes take place in the
animation.

In tween you need to create the starting and ending keyframes to animate
the object.

A frame is a single step of animation or picture on Flash timeline.
The rate of change between the frames used in tween is not constant.
A tween is a usable object in Flash.

D. Answer these questions.

1.

vk W

What happens in frame by frame animation?

Write a brief note on movie clip symbol.

What is shape tween?

Define a layer.

What is the difference between a symbol and an instance?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

7. Internet'and E-mail

A. Tick (v) the correct option.

1

3.

4.

The seed of the internet was planted in )
a. 1949 b. 1959

c. 1969 d. 1999
created Mosaic, a point and click Web browser.
a. NASA b. NCSA
c. DART d. IRDS
ASAP stands for )
a. As Soon As Possible b. After Sunday Again Monday
c. As Soon After Past d. After School Again Pride
An e-mail address has user name and name.
a. Company b. Domain
c. Second d. None of these

B. Expand these acronyms.

N -

3
4

. WWW

URL
HTTP
COBOL

C. State whether the given statements are True or False. Correct the false statements.

1

5.

Compose button is used to create and type a new e-mail.

2. The Bcc field is a one line introduction about the purpose of the e-mail.
3.
4

While writing an e-mail, avoid typing in small letters.

Blind Carbon copy is used to specify the addresses of all the recipients who
will also receive copies of the same e-mail.

A collection of related web pages is called website.

D. Answer these questions.

1

vk W

Define an acronym.

What is Internet?

What are emoticons? Give some examples.
How does the Web work?

What are the advantages of an e-mail?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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8. (Computer/Safetyand Security

A. Tick (v) the correct option.

1. A is a word or collection of characters used for user authentication to prove
the identity.
a. Iris b. Decryption
c. Password d. Biometric

2. a virus is the term used for cleaning a computer.
a. Cleaning b. Scanning
¢. Antivirus d. Eradicating

3. Norton, AVG and McAfee are some popularly used
a. Firewall b. Antivirus
c. Virus d. Malware

4, is an online backup service.
a. Google Drive b. Disk Cleanup
c. Disk Defragmenter d. None of these

B. Identify the type of malware from the clue given.
1. The prime motive of this is not to cause damage but to clone itself onto
another host to spread further.

2. Its primary function is to snoop on a user’s activity and send back the
information it gathers to a hacker.

3. It gains administrator access to the host system.
4. Tt takes a hard time jumping from one computer to another.
5. It enters into the computer bundled with other software or files.

C. State whether the given statements are True or False. Correct the false statements.

1. We should use a soft and clean cloth to wipe the screen.

2. Ransomware is the money demanded to release the hostage kidnapped for
the purpose.

3. Afirewall is a software that controls the incoming and outgoing network
traffic based on applied rule set.

4. Computer safety refers to the protection of computer based resources against

unauthorized use.
5. Rootkit works in a similar way as the spyware.

D. Answer these questions.

1. What is Disk Defragmenter?

2. What are online backup services?

3. What is meant by authentication? What are the types of authentication?
4. What steps need to be taken to clean the keyboard?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

9., Programming'with/Python

A. Tick (v)) the correct option.

1 are memory locations that are used to store values.
a. Constants b. Numbers
c. Symbols d. variables
2. Python has standard data types.
a. Two b. Four
c. Six d. Eight
3. The syntax of input command is
a. input(“prompt”) b. input “prompt”
c. input(prompt) d. input prompt
4. Python was developed in 1991 by .
a. Guido Van Rossum b. Mitchel Resnick
c. Donglas Engelbrat d. None of these
5. is an invalid variable name.
a. 123vicky b. vicky$
c. _vicky d. “vicky”
B. State the use of these operators with the help of an example and sample output.
1 // 2. ** 3. 1=
4. % 5 ==

C. State whether the given statements are True or False. Correct the false statements.
Python is an example of proprietary software.
. The Python interpreter executes the code one line at a time.

1

2

3. Avariable name can start with a digit.

4. IDLE stands for Integrated Document Level Environment.
5

Keywords are the reserved words in Python.

D. Answer these questions.
1. What is the use of logical operators?
2. What are comments in Python?
3. Write a short note on print() statement.
4. Define character set.
5. List any four features of Python.

Note: More Worksheets are available online. Visit www.thetouchpad.com
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LESSON PLAN

1. Computer /Networking

Teaching Objectives

Students will learn about

Computer network

Need for computer network
Advantages of computer network
Network terminology
Components required for a network
Types of network

Topology

Network architecture

Wireless networking technology

9 § 9 9 9 § 9 9 § 9§

Protocol

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that the process of connecting computers and peripheral
devices with each other to exchange data is called computer networking.

Tell the students about the meaning and basics of computer network.

Share with the students the need for computer network — for resource sharing and for communication.
Discuss with the students the advantages of a computer network.

Introduce network terms like Server (host computer) and Client (dependent on server).

Explain the different types of servers to the students covering dedicated server, print server, database
server, network server and web server.

Tell the students about the components required for a network covering NIC, hub/switch, router,
modem and networking cable.

Share with the students that on the basis of geographical area covered, the networks can be classified
into LAN (Local Area Network), MAN (Metropolitan Area Network), WAN (Wide Area Network), PAN
(Personal Area Network) and CAN (Campus Area Network).

Introduce Topology as geometric arrangement of computers or nodes in a network.

|
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Explain the difference between different types of topologies covering bus topology, ring topology,
star topology, tree topology and mesh topology (Refer Suggested Activity also).

Tell the students that the network architecture defines the overall design of the computer network.

Share with the students the two types of network architectures as Peer-to-Peer network and Client-
Server network.

Share with the students about the wireless networking technologies detailing about Wi-Fi and
Bluetooth.

Introduce Protocol as a set of rules that govern the communication between the computers on a
network.

Discuss briefly about the different types of protocols explaining about HTTP, HTTPS, FTP, TC/IP,
POP3, IMAP and SMTP.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.
Define computer network.

What is the need for a computer network?

What are the advantages of a computer network?
Define server / client.

What are the different types of computer servers?
What are the components required for a network?
Define LAN / MAN / WAN / PAN / CAN.

Define Topology.

Name different types of topologies.

DOOLOLOLOLOLDO

What is meant by protocol?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 14 and 15
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Page 16 of the main course book. Help
the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 16 of the main course book will
enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to make models of different types of topologies using marbles and used wire
pieces / straws.

]

opitn,
f_’100§ TouchPad Version 1.0-VIIl (Lesson Plan)

SS—

B



2. Introduction/to/MS/ Access 2010

Teaching Objectives

Students will learn about

Concept of a database

Types of databases

Advantages of a database system
Structure of a database

MS Access 2010

Components of MS Access 2010
Data types in MS Access 2010
Types of views in MS Access
Rules for writing a field name in MS Access

§ § 9 9 § 9 9 § § §

Creating a table

Teaching Plan Number of periods: 5

While teaching this chapter, tell the students that the computerized database system was introduced
in 1960s.

Introduce:

« Database as organizing data in a manner which helps to store and retrieve a large amount of
data efficiently.

« Database Management System as a collection of programs required to store and retrieve data
from a database.

Explain to the students the meaning of the two types of databases — Flat File Database and Relational
Database.

Share with the students the advantages of a database system.

Draw on board and explain the structure of a database to the students explaining about table, fields,
records, primary key, query, report and form.

Introduce MS Access 2010 as a powerful and easy to use Relational Database Management System
and is a part of MS Office Suite.

Demonstrate the steps to start MS Access 2010.

Familiarize the students with the various components of MS Access 2010 window covering Quick
Access Toolbar, Title Bar, Ribbon, Navigation Pane, Navigation Buttons, Work Area and Objects Tabs.

Demonstrate to the students the two ways of creating a database as:

« Creating a blank database

» Creating a database using Templates

Show the students the method to open an existing database and close a database.

\
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Explain different data types used in MS Access 2010 covering Text, Memo, Number, Auto Number,
Date/Time, Yes/No, OLE, Hyperlink and Lookup Wizard.

Discuss with the students the use of the different types of views in MS Access 2010 as Datasheet
view and Design view.

Share with the students the rules for defining field names in MS Access 2010.
Tell the students that Tables can be created in three ways.

Demonstrate to the students the steps to create a Table:

« In Design view

« In Datasheet view

¢ By using Templates

Show to the students the method to exit MS Access 2010.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

Define database.

What is Database Management System?

Expand DBMS.

Name the different types of databases.

What type of database is MS Access 20107

Give any two advantages of Database System.

Define Table / Query / Report / Form.

Name any three data types used in MS Access 2010.

What does OLE stands for?

What are the rules for writing field names?

DOLOLOLOLOLOLOL

What is the use of Field Name / Description in the Table design window?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 28 and 29
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Page 29 of the main course book. Help
the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 30 of the main course book will
enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to create a table storing information about details of their ten friends and sort the
records in the table in alphabetical order.

]
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3., Moreon MS Access 2010

Teaching Objectives
Students will learn about
& Forms in MS Access
@ Queries in MS Access
@ Reports in MS Access

Teaching Plan Number of periods: 3

While teaching this chapter, tell the students that MS Access is used to create tables and maintain
records in a database along with preparing Forms, Queries and Reports.

Introduce Forms as objects used to add, edit and display data from tables in a user friendly manner.

Share with the students that a Form can be displayed in three views — Form View, Design View and
Layout View.

Demonstrate to the students the steps to create a Form.
Explain different types of Forms covering Multiple Items, Datasheet, Split Form and Modal Dialog.

Familiarize the students with the Navigation Bar of the Form window to view and navigate between
records in a Table.

Tell the students that the appearance of the Form can be formatted using Design and Format tabs.

Introduce Query as the object that can give information which the user might not be able to find
by looking at the Table directly.

Explain the different types of Queries as: Select Query, Parameter Query, Action Query, Crosstab
Query and SQL.

Tell the students about the relationship between the Primary Key and the Foreign Key.
Show to the students the steps to define relationships between tables.
Demonstrate the steps to create a query.

Introduce Report as an object used to organize and present data in a user friendly format for printing
purpose.

Demonstrate the steps to:

» Create a Report

« Print a Report

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

Define Form / Query / Report.

Name the different views in which a Form can be displayed.

Name the different types of Forms in MS Access.

lolyelyeN e

Where is Navigation Bar located?
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Q. Name the different types of Queries.
Q. Define Primary Key / Foreign key.
Q. Name any four parameters of Query window.

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 39 and 40
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Pages 40 and 41 of the main course book.
Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Pages 41 and 42 of the main course book
will enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Using the Table created in the previous chapter create a query to display names of friends whose
name starts with A or D.

4. Listsiand Tables in' HTML

Teaching Objectives
Students will learn about
& Creating Lists

& Creating Tables

Teaching Plan Number of periods: 2
While teaching this chapter, tell the students that HTML tags are used to create a web page.
Introduce list as collection of related items.

Tell the students that there are three types of lists — Ordered List (Numbered List), Unordered List
(Bulleted List) and Definition List (Description List).

Explain the use of <OL> tag to create ordered lists, <UL> tag to create unordered lists and <DL>
tag to create definition lists. (See Suggested Activity 1 also).

Explain the use of <TABLE> tag and its child tags covering <TR>, <TD>, <TH> and <Caption>.

Explain the use of different attributes of <TABLE> tag covering BORDER, BORDERCOLOR, FRAMES,
BGCOLOR, BACKGROUND, HEIGHT, WIDTH, CELLSPACING and CELLPADDING.

Discuss the use of different attributes of <TD> tag explaining about ALIGN, BGCOLOR, WIDTH,
ROWSPAN, COLSPAN and VALIGN attributes.

Tell the students that all the attributes except ROWSPAN and COLSPAN are taken up by <TR> tag also.
Demonstrate the code to create a table and its data in HTML. (See Suggested Activity 2 also).
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

]
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Ask the students some oral questions based on this chapter.

Define List / Table.

How many types of Lists can be created in HTML?

Name the different types of Lists that can be created in HTML.
What is an Ordered / Unordered / Definition List?

Name the attributes of <OL> tag.

Name the tags used to create Definition List.

Name the tags that can used to create different kinds of tables.
What are the attributes of <TABLE> / <TD> tag?

ODOOLOLLOLOLOL

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 51 and 52
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Pages 52 and 53 of the main course book.
Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 53 of the main course book will
enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to create:

 List of favourite games of 10 friends.
« Table of car names and their models.

5. Moreon HTML

Teaching Objectives
Students will learn about
& Inserting Images

@ Creating Marquee
@ Linking Web Pages
& Frames

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that HTML allows inserting images and frames on web
pages as well as interlinking them.

Tell the students that HTML supports JPEG, GIF and PNG image formats.

Tell the students that <IMG> tag is used to insert images and it takes the attributes as SRC, WIDTH,
HEIGHT, ALIGN, BORDER and ALT.

Demonstrate to the students the use of <IMG> tag and its attributes.

\

M
TouchPad Version 1.0-VIIl (Lesson Plan) {405 =

ol

-



Introduce Marquee as the moving objects on a web page to get special attention of the users.
Explain the use of <MARQUEE> tag and its attributes as BEHAVIOUR, DIRECTION and SCROLLAMOUNT.

Make the students understand that a hyperlink is an underlined text or an image which when clicked
takes the user to some other location.

Share with the students that <A> is used to create links and the attributes that this tag can take
are — LINK, ALINK and VLINK.

Demonstrate the use of <A> tag and its attributes to hyperlink web pages (See Suggested Activity
also).

Introduce Frames as a feature to display more than one web page on a single screen of the web
browser.

Explain the use of <FRAMESET> tag and <FRAME> tag to create and define frames on a web page.
Tell the students that the <FRAME> tag can take FRAMEBORDER, NORESIZE and SRC as attributes.
Demonstrate the use of <FRAMESET> and <FRAME> tags to create frames on a web page.
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.

Ask the students some oral questions based on this chapter.

Which tag is used to insert images on a web page?

State the use of SRC / WIDTH / ALIGN /ALT attribute of IMG tag.

Which image formats are supported by HTML?

What is the use of MARQUEE tag?

Which tag is used to link web pages?

Name the attributes that can be taken by FRAME tag.

OOoOOLDO

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 63 and 64
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Pages 64 and 65 of the main course book.
Help the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Pages 65 of the main course book will
enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to create an e-shopping web site listing categories of items on home page and
details of items on separate category pages.

6. More/on/Photoshop/CS6

Teaching Objectives
Students will learn about
@ Retouching tools

]
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< Correction tools
@ Working with Layers

Teaching Plan Number of periods: 4

While teaching this chapter, tell the students that Adobe Photoshop is used for creating and editing
images in order to make them look attractive.

Introduce retouching tools as the tools used to add or remove features to an image.
Demonstrate the use of Retouching Tools like:

» Spot Healing Brush Tool (used to repair dark spots, scratches, etc.)

» Clone Stamp Tool (used to duplicate parts of an image)

« Pattern Stamp Tool (used to give attractive textures and backgrounds to an image)
Demonstrate the use of Correction Tools like:

» Blur Tool (used to blur parts of an image)

« Sharpen Tool (used to improve quality of an image)

»  Smudge Tool (used to show image as wet paint on the image has been spread by finger)

Introduce Layers as transparent sheets containing objects which are stacked on top of each other
so that individual properties of an object can be edited without affecting other objects.

Explain how to create a new layer and delete an existing layer from an image.
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

Q. What is Photoshop used for?

Q. What are Retouching Tools?

Q. Name some important retouching tools in Adobe Photoshop CS6.
Q. What is the use of Correction tools in Photoshop?

Q. Name the important correction tools of Photoshop.

Q. What are layers?

Q. What is the use of Layers in Photoshop?

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 72 and 73
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Page 73 of the main course book. Help
the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 74 of the main course
book will enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to arrange a scanned copy of their passport size photo and apply retouching and
correction tools to beautify the image.

\
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7. Internet/Services/and Cyber/Crime

Teaching Objectives
Students will learn about
< Internet services

& Cyber security

@ Cyber crime

& Hacking and Cracking

Teaching Plan Number of periods: 3

While teaching this chapter, tell the students that internet is used for a wide variety of services
including communication, shopping and banking.

Tell the students that internet services allow us to perform different types of operations over the
internet.

Explain how internet plays an important role in communication through e-mails, video conferences,
voice-over-internet protocol, chat, social network, newsgroup and blogs.

Demonstrate the steps to use:

» VoIP services

» Blogging

Share with the students how internet is used to:

« Send greetings in the form of e-greetings

« Send and receive money through e-banking
 Store data and information through cloud storage

Introduce Cyber Security as the process of protecting computer resources such as networks, devices,
programs and data from unauthorized access, damage or attack.

Share with the students the reasons for increase in cyber-crimes.
Introduce cyber-crime as a criminal activity in which computers are used to do crimes.
Explain the different types of cyber-crimes covering data diddling, phreaking, cloning and carding.

Make the students understand the difference between hacking (practice of modifying computer
hardware and software for legal purposes) and cracking (practice of modifying computer hardware
and software for illegal purposes).

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

Name some internet services.

Define Video Conferencing / VoIP.

What are the advantages and disadvantages of VoIP?

Define chatting / social networking / blogging.

What is meant by cloud storage?

DOOOO
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Q. Name some cloud storage services.

Q. Define Cyber Security / Cyber Crime.

Q. What are the different types of cyber-crimes?
Q. Differentiate between hackers and crackers.
Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 85 and 86
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Page 87 of the main course book. Help
the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 87 of the main course book will
enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Ask the students to collect information about different types of major cyber-crimes committed in
last one year.

8., (Control Structures/in/Python

Teaching Objectives

Students will learn about

@ The input() and the print() functions
Conditional statements

Looping statements

Jump statements

9 9 9

Teaching Plan Number of periods: 4
While teaching this chapter, tell the students that Python is an object-oriented programming language.
Recall with the students the use of:

« The input() function

* The print() function

Demonstrate to the students the use of these functions.

Introduce conditional statements as the statements used to change the default flow of a program.
Explain that Python offers three decision making statements:

o if statement
« if...else statement
o jf...elif...else statement

Explain the situation when these statements are used and demonstrate the use of each statement.

Introduce looping statement as the statement that allows repeating a set of instructions a given
number of times.

\
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Share with the students the use and syntax of the ‘for’ loop.

Tell the students that jump statements are used to transfer the control of the program outside the
loop even if all the values of the sequence have not been taken.

Share with the students that the jump statements offered by Python are:

¢ The break statement (used to terminate the loop).

« The continue statement (used to force the next iteration of the loop and skip the current iteration).
Demonstrate the use of the jump statements in Python.

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is Python?

What is the use of the input() / print() function?

What is the use of conditional statements?

Name the conditional statements used in Python.

What are looping statements used for?

What is the use of Jump statements in Python?

OOoOLOOLOLOL

Name the jump statements used in Python.

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 98 and 99
of the main course book as One Touch Learn and Let's Do It. After solving the course book exercises,
tell the students to solve Crack the Code activity given on Page 100 of the main course book. Help
the students to solve these questions.

In Creative Assignment, activities like Fun in Lab given on Page 101 of the main course book will
enhance the ability of the students and serve as a Subject Enrichment activity.

Suggested Activity

Write a program in Python to:

« Input 5 numbers and check which of these numbers are prime or composite.
« Input age of a person and check whether he or she is a senior citizen or not.

 Calculate the average marks of three students in four subjects each and arrange the averages in
ascending order.

9., Artificial Intelligence

Teaching Objectives

Students will learn about

@ The birth of Artificial Intelligence
@ What is Artificial Intelligence?

]
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@ What can Artificial Intelligence do today?
= Implementing Artificial Intelligence
@ Philosophers views on Artificial Intelligence

Teaching Plan Number of periods: 2

While teaching this chapter, tell the students that human brain has the ability for reasoning, problem
solving and learning.

Make the students aware about the birth of the concept of artificial intelligence.
Explain the students in detail about the concept of artificial intelligence.

Share with the students the various fields in which artificial intelligence is being successfully
implemented covering:

+ Robotics vehicles

* Speech recognition

*  Game playing

« Autonomous planning and scheduling

» Logistics planning

» Robotics

* Machine translation

* Machine vision

« Natural language processing

* Machine learning

Explain to the students the philosophers’ views on artificial intelligence laying significance on:
* Weak Al Hypothesis

« Strong Al Hypothesis

Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is AI?

Who is the father of AI?

Name some fields where Al is being implemented.

What is Weak Al Hypothesis?

What is Strong Al Hypothesis?

(el elyeN elye)

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 106 and
107 of the main course book as One Touch Learn and Let's Do It. After solving the course book
exercises, tell the students to solve Crack the Code activity given on Page 107 of the main course
book. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 107 of the main course
book will enhance the ability of the students and serve as a Subject Enrichment activity.

\
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10. Robotics

Teaching Objectives
Students will learn about
& Robots and Robotics
& Uses of Robotics

< Androids
.

Mechatronics

Teaching Plan Number of periods: 2

While teaching this chapter, tell the students that computers have made technological advancements
into robotics industry.

Introduce the terms robots and robotics to the students.

Share with the students the various uses to which robotics can be put to.

Explain the different types of robots as industrial robots and service robots.

Tell the students about androids as robot designed to execute highly sophisticated instructions.
Introduce mechatronics as a new fields arising out of combination of mechanics and electronics.
Ensure that the scope of Teacher's Corner given at the end of the chapter has been covered.
Ask the students some oral questions based on this chapter.

What is a robot?

What is robotics?

State two uses of robotics.

Define android.

What is mechatronics?

Oooo0oo

Evaluation

After explaining the chapter, let the students do the course book exercises given on Pages 111, 112
and 113 of the main course book as One Touch Learn and Let's Do It. After solving the course book
exercises, tell the students to solve Crack the Code activity given on Page 113 of the main course
book. Help the students to solve these questions.

In Creative Assignment, activities like Hands-On and Fun in Lab given on Page 113 of the main course
book will enhance the ability of the students and serve as a Subject Enrichment activity.
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1., Computer Networking

One Touch Learn R

One Touch Learn )

ats oo 1

A.

A.
B.
C
D

ANSWER KEY

1. (a) 2. (o) 3. (b) 4. (o

LT 2. T 3.7 4. T 5T
1. protocol 2. SMTP 3. router 4. mesh 5. NIC
Ring Tree Bus Star

1. Protocol is a set of rules that governs the communication between the computers over a
network.

2. The components needed for a network are:

3. Aclient is a computer which depends on the server for all the resources.
A server controls the access to the hardware and software on the network.
4. Topology refers to the geometric arrangement of computers or nodes in a network.

1. Computer network means a system of interconnected computers. The advantages of
computer network are:

(i)
(ii)
(iii)
(iv)

)
(vi)

Network Interface Card (NIC)

Hub or switch

Router

Modem

Networking Cable (Ethernet Cable)

The information can be easily shared by the people.
It helps in reducing the cost of hardware.
Store information on one centralised location.

(Aoy 1amsuy) [[|A - 0° L UOISISA AVdHONOL

Reliability implies backing up of information. If a system crashes, then the information
is accessible on another workstation for future use.

Reduction in installation cost.
User authentication process to secure the data.

\
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(vii) People will have the accessibility to all the information they need to get and share
through e-mails and instant messaging which saves time and money in passing
information.

2. ALAN s a digital communication system that interconnects a larger number of computers
and other peripheral devices within a radius of less than 1 km.

MAN consists of two or more local area networks or campus area networks together that
usually spans several buildings in the same city or town.

Crack The Code

A. 1. Ring Topology 2. Network Server
B.
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2. Introduction/to MS/ Access'2010

One Touch Learn )

| FUN [in LLAB

Do yourself.

A. 1 (b 2. (a) 3. (0 4. (o) 5. (d)

B. 1T
2. F Correct Statement: Navigation Pane is present on left side of MS Access window.
3. F Correct Statement: The maximum size of Number field is 16 bytes.
4. T

C. 1 table 2. field 3. primary 4. sort 5. navigation

. N
1 48 TouchPad Version 1.0-VIII (Answer Key)
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A. 1. Primary key is a unique field by which the records are identified in a table.

2. The final result of the manipulated data that comes from tables or queries in DBMS is
known as the report.

3. Aquery is the most powerful feature of database. It helps you to retrieve information from
a table based on some criteria or condition.

4. A From is a window on which the data is displayed.
B. 1. Toadd arecord:

Step 1 Open the required table in Datasheet view from the Navigation pane.
Step 2 Place the pointer where you want to add the new record.
To delete a record:
Step 1 Open the required table in Datasheet view.
Step 2 Select the record which you want to delete.
Step 3 Right-click and select the Delete Record option.

2. The Datasheet View shows all the fields and the records as entered by the user. In this view,
you can edit the content of the table.

In Design View records are not visible. You can only see the field names along with their
data types. You can add or delete a field name.

C. 1. The advantages of DBMS are:
(i) It minimizes the duplication of data by integrating and sharing the data files.
(i) It saves the storage space.
(i) All the users are provided with some access rights or privileges and permissions.
(iv) The files can be easily updated whenever any changes are being made.
2. There are two types of views in MS Access:

o Datasheet View: It is the default view of the table. It shows all the fields and the
records as entered by the user. In this view, you can edit the content of the table.

e Design View: In this view, the records are not visible. You can only see the field
names along with their data types. You can add or delete a field name.

3. Rules for writing field names are:
(i) The field name can be up to 64 characters long.

(i) It can include any combination of letters, numbers, spaces, and special characters
except a period (.), an exclamation mark (!), an accent grave (') and brackets ([ ]).

(ili) It cannot begin with the leading spaces.
(iv) It cannot include a double quotation mark (*).

Crack The Code %

A. Using Templates
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Do yourself.

3., Moreron MS Access 2010

One Touch Learn )

A.
B.

n

L T R e

(b) 2. (b) 3. (0 4. (o)

F Correct Statement: You can run a query many times.

F Correct Statement: You can insert a picture in the form.

F Correct Statement: Logo can be added in the Form window.

F Correct Statement: Layout view is used to change the appearance of the form.
T 6. T

title and logo 2. select query 3. relationship 4. run
C 2. a 3. d 4. b

@

Let's Do It <

A.

N

ij;i;.GSTouchPad Version 1.0-VIIl (Answer Key)

1.

We need a form to create, edit and display data stored in tables in a user-friendly manner.

Report allows you to organize and present your data in a user-friendly format so that it
can be printed.

Three view are:
(i) Form View (i) Design View (i) Layout View



B. 1. Using a query, you can search or compile data from one or more tables in a database by
giving specific search conditions so that you are able to view the exact data that you want.
On the other hand, report allows you to organize and present your data in a user-friendly
format so that it can be printed.

2. A Primary Key is a unique field by which the records are uniquely identified in a table. To
create a relationship, it is necessary to have a primary key in a table.

3. A Foreign Key is a column in one table that must match the Primary Key of another table.
To establish link between Primary Key and Foreign Key:

Step 1 Click on the Relationships command from Relationships group under Database
Tools tab.

Step 2 The Show Table dialog box will open. Click on the Add button. The selected table
will appear in the relationship window.

Step 3 Click and hold on the Primary Key field of one table.

Step 4 Drag the mouse pointer to the common field in the other table and release the
mouse button.

Step 5 This will open Edit Relationships dialog box. Click on the Create button.

Crack The Code

A. 1. Report
2. Yes, by using Query feature
3. Crosstab Query
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Do yourself.
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Periodic/Assessment-1
(Based on chapters 1 to 3)

A. 1. Network Server 2. Mesh Topology 3. MAN
4. Datasheet View 5. Number

B. Ring Topology Star Topology

C.

Quick Access Toolbar Title Bar

e Database Tools Acrobat Fields Table (A
ﬂéi“l j E@@Ejﬁi - Rl i
) A o m Ribbon
Application | Table Table SharePoint Query Query | Form Form Blank Report Report Blank Macro
Parts = Design Lists = Wizard Design Design Form EI' Design Report n_‘
Templates Tables Queries Forms Reports Macros & Code
All Access Objects ® « || 23 Tabler xl ObjeCtS Tabs
[Search. 2 D - | Click to Add ~
Tables r | E3 (New)
EH Tablel
Navigation
Pane
Work Area
Record: 14 lofl L a"\ No Filter Search

Datasheet View \ Num Lock |4

Navigation Buttons

4. Lists;and Tables in' HTML

mmm@
(@ 3. (b)

F Correct Statement: The START attribute accepts numeric and character values.
F Correct Statement: Unordered list is used to create a bulleted list.

F Correct Statement: The <TABLE> tag is used to create a table in HTML.

F Correct Statement: The <TR> tag is used to create rows in the table.

T

Ll A e o e

ordered list 2. list item 3. <UL> 4. disc 5. <CAPTION>

Lets Do It

A. 1. Alistis a collection of related items.
2. Table represents data in the form of rows and columns.
3. The description list is a type of list in which terms with their definitions are displayed.

\ ¥
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1.

2.

3.

The main difference between ordered list and unordered list is that the ordered list displays
the items in a sequential manner and unordered list displays items in an non-sequential
manner.

The attributes of the <TABLE> tag are BORDER, BORDERCOLOR, FRAMES, BGCOLOR,
BACKGROUND, HEIGHT, WIDTH, CELLSPACING and CELLPADDING.

The ROWSPAN attribute applies when a single cell is extended for more than a single row
and the COLSPAN attribute applies when a single cell is extended to more than a single
column.

o)
Crack The Code %)

A.

1.

<OL> Tag 2. <TABLE> Tag 3. COLSPAN

(ellz]clof=]a|=]a]>] =)
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Do yourself.

5. Moreon HTML

One  Touch Learn )

A.

1.

(©) 2. (b)

<
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F Correct Statement: The default colour of the visited link is purple.

F Correct Statement: We can specify the width and height of an image in a web page.
F Correct Statement: PNG image file format stands for Portable Network Graphics.
T

internal link 2. <A> 3. DIRECTION
b 2. d 3. a 4. ¢

@

Lets Do It

A.

Crack The Code

CEDDEXY

A.
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2
3
4.
5
1

N

1
2.

t

Some of the image formats supported by HTML are Joint Photographic Experts Group
(JPEG), Graphics Interchange Format (GIF) and Portable Network Graphics (PNG).

. ALINK stands for Active Link and VLINK stands for Visited Link.

Frames are the different sections or parts of a web page.
GIF stands for Graphics Interchange Format.

. The ROWS attribute of the <TABLE> tag is used to divide the window horizontally.

a. The SCROLLAMOUNT attribute is used to specify the speed of the moving object in
a marquee.

b. The HREF means Hyperlink Reference which gives reference to the address of the
web page.
¢. The ALT attribute specifies the alternate text to be displayed in the web browser, if
the provided image is not found.
Attributes used with <IMG> tag are SRC, WIDTH, HEIGHT, ALIGN, BORDER and ALT.

Frames are used to display more than one web pages on a single screen of the web browser.
Frames are the different sections or parts of a web page. The <FRAMESET> tag is used to
divide the web page into different sections or partitions.

. The attributes of the <FRAME> tag are:

(i) FRAMEBORDER: This attribute is used to define whether a border is to be created
around the frame or not.
(i) NORESIZE: This attribute is used to restrict the user to resize the frame on the web
page.
(iii) SRC: This attribute is used to define the URL or path of the web page which is to be
linked to the frame.

11

<FRAMESET> tag
Yes, by using the <MARQUEE> tag

optn,
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Periodic/Assessment-2
(Based on chapters 4 & 5)
A. 1. The <TD> tag stands for Table Data. It is used to fill the data in the table cells.
2. The <DL> tag is used to create a definition list.
3. VLINK stands for Visited Link. It is used to specify the color of visited links.
4. The <A> tag is used for creating links in the HTML web pages.

5. The <MARQUEE> tag is used to add a moving text or image on the Web page.
B. <HTML>

<HEAD> <TITLE> </TITLE> </HEAD>

<BODY>

<OL>

<LI> Hardware </LI>

<OLTYPE="T">

<LI> Printer

<LI> Webcam </OL>
<LI> Software

<OL TYPE="T">

<LI> MS Office

<LI> Adobe Photoshop
</OL>

</OL>

</BODY>

</HTML>

| —7
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C. <HTML>

<HEAD> <TITLE> </TITLE> </HEAD>
<BODY>

<TABLE BORDER="1">
<TR ALIGN="Center">
<TD>ROLL NO.</TD>
<TD COLSPAN="2">Name</TD>
<TD>Marks</TD>
<TD>Grade</TD>
</TR>

<TR ALIGN="Center”>
<TD></TD>
<TD>First</TD>
<TD>Llast</TD>
<TD></TD>
<TD></TD>

</TR>

<TR ALIGN="Center">
<TD>1.</TD>
<TD>Nisha</TD>
<TD>Batra</TD>
<TD>81</TD>
<TD>A</TD>

</TR>

<TR ALIGN="Center”>
<TD>2.</TD>
<TD>Nidhi</TD>
<TD>Gupta</TD>
<TD>85</TD>
<TD>A+</TD>
</TR>

<TR ALIGN="Center">
<TD>3.</TD>
<TD>Vikas</TD>
<TD>Arora</TD>
<TD>72</TD>
<TD>B</TD>

</TR>

</TABLE>

</BODY>

</HTML>

]
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Test Sheet-1

(Based on chapters 1to 5)

Section A

(d) 2. (b) 3. (0 4. (b)

(b) 6. (b) 7. (b) 8. (b)

SMTP 2. Router 3. Table 4. Sorting 5. Query

Run 7. Disc 8. <TABLE> 9. <A> 10. internal link
Section B

A server is a computer that controls the access to the hardware and software on the network.

A client is a computer which depends on the server for all the resources.

DBMS stands for Database Management System.

A query helps you to retrieve information from a table based on some criteria or condition.
A list is a collection of related items.

ALINK stands for Active Link and VLINK stands for Visited Link.

The computer network means the system of interconnected computers. The advantages
of computer network are:

(i) The information can be easily shared by the people.
(i) It helps in reducing the cost of hardware.
(iii) Store information on one centralised location.

(iv) Reliability implies backing up of information. If a system crashes, then the information
is accessible on another workstation for future use.

(v) Reduction in installation cost.
(vi) User authentication process to secure the data.

(vii) People will have the accessibility to all the information they need to get and share
through e-mails and instant messaging which saves time and money in passing
information.

The Datasheet View shows all the fields and the records as entered by the user. In this view,
you can edit the content of the table.

In Design View records are not visible. You can only see the field names along with their
data types. You can add or delete a field name.

A Primary Key is a unique field by which the records are uniquely identified in a table. To
create a relationship, it is necessary to have a primary key in a table.

4. Attributes of the <TD> tag are ALIGN, BGCOLOR, WIDTH, ROWSPAN, COLSPAN and VALIGN.

Frames are used to display more than one web pages on a single screen of the web browser.
Frames are the different sections or parts of a web page. The <FRAMESET> tag is used to
divide the web page into different sections or partitions.

\
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C. <HTML>
<HEAD> <TITLE> </TITLE> </HEAD>
<BODY>
<FONT COLOR="red">
<U>
<H2 ALIGN="center">
Let's Reduce Global warming!</H2>
</U>
</FONT>
We can reduce Global Warming by:
<UL TYPE="square">
<LI>Reducing our consumption of fossil fuels
<LI>Driving less. Walking, biking or carpooling
<LI>Recycling more
<LI>Using less hot water
<LI>Planting a tree
<UL>
</BODY>
</HTML>

6. Moreion/Photoshop/CS6

One Touch Learn )

A. 1 (b 2. (a) 3. (d)
B. 1. F CorrectStatement: We can delete a layer in Photoshop once it is created.
2. F Correct Statement: Blur Tool is used to blur the background of the selected image.
3.7
4. F Correct Statement: Spot Healing Brush Tool is not same as Healing Brush Tool.
C. 1. Smudge 2. Sharpen 3. Clone Stamp
Let's Do It

A. 1. Smudge Tool Blur Tool Clone Stamp Tool Sharpen Tool
Spot Healing Brush Tool Pattern Stamp Tool

2. The difference between Spot Healing Brush Tool and Healing Brush Tool is that the latter
requires a source point.
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3. Layers are transparent sheets containing objects which are stacked on top of each other

so that individual properties of an object can be edited without affecting other objects.

4. The Smudge Tool is used to show the image as the wet paint on the image has been spread

by finger.

1. To use Clone Stamp Tool:

Step 1 Open the image and then click on Clone Stamp Tool from the Toolbar.
Step 2 Select the brush size and hardness from Options bar.

Step 3 Press and hold the Alt key and click on the image to be cloned.

Step 4 Click and drag the mouse at the place where the clone is to be created.

Step 5 When you drag the mouse pointer, you will see a plus sign on the original image
and a small circle on the cloned image.

Step 6 Release the mouse button when clone completed.

2. Layers are transparent sheets containing objects which are stacked on top of each other

so that individual properties of an object can be edited without affecting other objects.
We can add new layers, change the position of layers, delete layers and customize layers.

Crack The Code %’)

A.

1. Spot Healing Brush Tool 2. Clone Stamp Tool
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7. Internet/Services/and Cyber/Crime

i

One  Touch Learn )

A. 1 (d) 2. (a) 3. (0
B. 1T 2.7

3. F Correct Statement: News Admin keeps a check on the comments of participants on
newsgroup.

4. T 5 T

C. 1. carding 2. blogs 3. chat
s
%
Let's Do It
A. 1. Phreaking is a cyber crime committed against telephone companies by using computers.

2. A newsgroup is a discussion group that focuses on a particular topic.

3. No, because these services are generally considered as a source of distraction from education
for students.

4. Computer hacking is the practice of modifying computer hardware and software to
accomplish a goal outside of the creator’s original purpose.

5. Cloud storage is a service where the users are able to store and manage data on remote
server in place of their local computer.

B. 1. To upload a file on Google Drive:
Step 1 Visit www.google.com/drive/ web page.
Step 2 Click on Go to Google Drive button.
Step 3 Enter your Gmail account'’s username and then click on Next button.
Step 4 Enter password and then click on Next button. This will open your Google Drive
web page.
Step 5 Click on My Drive option. This will open a drop-down list.
Step 6 Click on Upload Files to upload and store your file on the remote server.

2. Blogs are generally like a detailed explanation on a subject or sometimes also as a Diary of
Events. It is a discussion platform where the readers of the blog can add their comments
and suggestions. These posts are displayed in descending order of time, which means the
latest post is shown at the top.

3. Different types of communication techniques are:

]

SS—

=

(i) E-mail: E-mail stands for electronic mail. You can send messages and files from your

computer to your friend’s computer and vice-versa using e-mail service.

(i) Video Conferencing: It is a technique of watching the person whom you are talking.

(iii) Voice-over-Internet Protocol (VoIP): It is a technology which gives calling facility
over the Internet.

(iv) Chatting: Refers to a communication in the form of small messages among the
computers over the Internet, just like SMS service on mobiles.

(v) Social Networking: It is a platform where people with common interest or activities
can connect with each other.

optn,
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4. To register on Skype:

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Download the Skype from the www.skype.com website and install it on your
computer.

Double click on Skype icon to start Skype.

Click on Sign in or Create button to create an account on Skype.

Click on Create one! link. The Create account screen appears.

Enter your email and click on Next button.

Enter a password and click on Next button.

The Skype asks you about your personal details. Then, click on Continue button.
Skype further asks you for checking your microphone and webcam. Click on Continue
button each time.

5. Some of the cyber crimes are:

(i)
(ii)
(iii)

(iv)

Data Diddling: Refers to the process of changing the data going into or out of a
computer.

Phreaking: Refers to the crime that is committed against telephone companies.
Cloning: Refers to a fraud in which scanners are used to steal the electronic serial
numbers of cellular phones, which may used for billing purposes and making
broadcast calls.

Carding: Refers to the process of stealing credit card numbers online, to be resold
or used to charge merchandise against victim’s account.

Crack The Code

A. 1. Popular blogging websites are Blogger, Wordpress, Tumblr, etc.
2. By uploading the files on cloud storage services, Alia can carry her back-up.
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Periodic/Assessment-3
(Based on chapters 6 & 7)
A. 1. Clone Stamp Tool and Pattern Stamp Tool
2. E-banking and Social Networking
3. Blur Tool and Sharpen Tool
4. Cloning and Carding
5. Facebook and Twitter
B. 1. Layers are transparent sheets containing objects which are stacked on top of each other
so that individual properties of an object can be edited without affecting other objects.
2. E-banking, also known as Internet banking, is an electronic payment system.
3. Computer hacking is the practice of modifying computer hardware and software to
accomplish a goal outside of the creator’s original purpose.
C. 1. Photoshop 2. Chatting 3. pirated
4. E-mail service provides 5. Retouching 6. Layers
7. duplicate 8. cyber security
D. 1 c 2. e 3. a 4. f 5 b 6. d

8., (Control Structures/in/Python

e

One Touch Learn )

A. 1 (b 2. (d) 3. (0 4. (a) 5. (b)
B. 1T 2.7
3. F Correct Statement: The break statement is used to break the execution of a loop.
4. T
5. F Correct Statement: The conditional statement is used to control the flow of execution
of a program based on a given test condition.
C. 1. break 2. if 3. continue 4. print() 5. input ()
D. 1 c 2. d 3. a 4. b
Let's Do It
A. 1. The print() function is used to display the output on the screen.

2.
3.

]
\

To change the default flow of a program, we use conditional statements.
We use jump statements to transfer the control of the program outside the loop.
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B. 1. The if statement allows you to test a condition before executing the statements and the
if....else statement is used to execute either of the block of statements from if or else
statements.

2. The break statement terminates the loop within which it lies. It skips rest of the statements
in the loop and jumps over to the statement following the loop. For example,

for x in [10, 15, 20, 25]:
if(x == 20):
break
print(“the value of x is”, X)
print(“Thank You!")
In the preceding code, loop stops executing when the value of x becomes 20.

3. The for loop is designed to process the items of any sequence one by one. The syntax of
the for loop is:

for <variable> in <set of values>:
[statements to repeat]

The variable is a loop variable that controls the iterations of the for loop. The set of values
written after the in keyword is the sequence of elements from where the variable will derive
its value while repeating the statements written in the body of the for loop. For example,

for x in [10, 15, 20, 25]:
print(“the value of x is", x)
print(“Thank You!")

Crack The Code %}

A. 1 10
20
30
40
50
2.3
4
5
6
3. Syntax Error. Colon is missing from for loop.
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numl = int(input("Enter first number: "))
num2 = int(input(“Enter second number: "))
if(num1%num2==0):
print(“First number is divisible by second number”)
else:
print(“First number is not divisible by second number”)
numl = int(input("Enter first number: "))
num2 = int(input(“"Enter second number: "))
num3 = int(input("Enter third number: *))
if (num1 >= num?2) and (huml >= num3):
print(hnum1, “is the largest number”)
elif (num2 >= numl) and (num2 >= num3):
print(hnum2, “is the largest number”)
else:
print(hnum3, “is the largest number”)
age = int(input(“"Enter your age: "))
ifage>=18):
print("You are eligible to vote”)
else:
print("You are not eligible to vote”)
sum =0
foriinrange (1,11,1):
sum +=i
print(“Sum of first 10 natural numbers is:”, sum)

]
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numl = int(input("Enter a number: "))
if(num1 < 0):

print(“Entered number is negative”)
elif(numl == 0):

print(“Entered number is zero")

else:

print("Entered number is positive”)

9., Artificial Intelligence

One Touch Learn )

A.
B.

C.

1
1.
2.
3
1

(a) 2. (b) 3. (a)

T

F Correct Statement: Machine Learning is a subset of Al that includes statistical techniques.
T

brain 2. carthy 3. deepblue 4. machine learning

ats oo 1

A.

1.

Artificial Intelligence is an area where computer science and engineering emphasizing on
creation of intelligent systems that can work and react like humans.

2. John McCarthy first coined the term “Artificial Intelligence” in 1956 at Dartmouth conference.

The assertion that machines that do so strong Al are actually thinking (not just simulating
thinking) is called the strong Al hypothesis.

Artificial Intelligence has advanced very rapidly in the past decade because of greater use
of science, engineering and mathematics in experimenting and comparing approaches.
Artificial Intelligence research also overlaps with tasks such as robotics, control systems,
scheduling, data mining, logistics, speech & facial recognition etc.

Philosophers have been trying to find the answers to questions, will machines be able to
act intelligently as humans? and if they did, would they have real and conscious mind?
What will be the ethical implications of intelligent machines?

Artificial Intelligence and related technologies however seems to pose some fresh problems
like:
(i) People might lose their jobs due to automation.
(i) People might have too much ( or too little) leisure time.
(iii) Artificial Intelligence systems might be used towards undesirable ends.
(iv) The use of Artificial Intelligence systems might result in a loss of accountability.

\
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But all these threats are hypothetical and can be combated with scientists and engineers
who work on Artificial Intelligence and related technologies. They should think and act in
a way that is beneficial to mankind and society.

3. Artificial Intelligence is being successfully implemented in:

(i) Robotics Vehicles: Driverless robotic cars outfitted with cameras, radar and laser
range finders to sense the environment and software to command & control steering,
brakes and accelerator and also obey the traffic rules.

(i) Speech recognition: Conversation guided by an automated speech recognition and
dialog management system.

(ili) Game playing: IBM’'s Deep Blue became the first computer program to defeat a
world champion in a chess match.

(iv) Autonomous planning and scheduling: NASA’s Remote Agent program became
the first on board autonomous planning program to control the scheduling of
operations for a spacecraft.

Crack The Code

1. ROBOTICS

2. ARTIFICIAL
INTELLEGENCE

3. MACHINE
VISION

4. LOGISTICS
PLANNING

5. ALAN
TURING

o
| FUN |in | LAB L4

Do yourself

10. Robotics

One  Touch Learn )

A. 1 (0 2. (a 3. (b) 4. (0 5. (a)
B. 1T
2. F Correct Statement: Robots are classified into two types.
3.7
4. F Correct Statement: A robot developed in England can attack insects.
5. F Correct Statement: Robotic surgery reduces pain.

-}
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C. L
4.

robot 2. autonomous robots 3. integrated circuit
Dante II

ats oo 1

A. 1
2.

Crack The Code R

A 'human like’ machine that can do automated tasks is called a robot.

The field of mechanics and electronics together have given rise to a new engineering sector
called Mechatronics.

Unmanned surgery, surgery with minimum cutting or puncturing of skin has been possible
because of robots.

. There are two types of robots:

(i) Industrial robots are mainly used in manufacturing industries such as automotives
industries. These robots are programmed using computers.

(i) Service robots include domestic robots that clean the carpet or cut grass in the garden
and move on their own. They are fully or semi-autonomous robots and controlled
by electronic circuits.

Programmed robots can now track cyclones and weather conditions. With the help of
computers it is possible to view images from satellites. More and more research projects
aim at predicting the natural disasters in advance to avoid serious damage and protect the
inhabitants of that area.

Robotics gained a vital place in the environmental sector. A robot developed in England
can attack insects like some omnivorous plants. Also a London aquarium exhibits a robot
that has been inspired by a fish.

Decoded Message:

WITH THE ADVANCEMENT IN TECHNOLOGY, ROBOTS HAVE BECOME SO POWERFUL THAT IN NEAR
FUTURE, THEY MAY ENSLAVE THE HUMAN RACE. TOO MUCH ADVANCEMENT MAY ALSO PROVE
HARMFUL. WE MUST BE PREPARED TO FACE THE CRISIS.

®
_FUN [in | LAB L4

Do yourself
Periodic/Assessment-4
(Based on chapters 8 to 10)
A. 1. The if..elif..else statement 2. The for loop
3. The break statement 4. The continue statement
B. 1. Alan Turing 2. Karel Capek
3. Issac Asimov 4. Tetsuro Mori

| —7
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C. 1. 100is <=500

200 is <= 500
300 is <= 500
Let's Break!
2. 100is <= 500
200 is <= 500
300 is <= 500
500 is <= 500
Let us Continue!
3. 100
The number is even

D. numl = int(input("Enter first number: “))

num?2 = int(input(“Enter second number: "))
if(numl1 % 3 == 0):
if(numl % 4 == 0):
print(“First number is divisible by both 3 and 4")
else:
print(“First number is only divisible by 3")
else:
print(“First number is not divisible by 3 and 4")
if(hum2 % 3 == 0):
if(num2 % 4 == 0):
print(“Second number is divisible by both 3 and 4")
else:
print(“Second number is only divisible by 3")
else:
print(“Second number is not divisible by 3 and 4")

Test Sheet-2

(Based on chapters 6 to 10)

Section A
A. 1 (0 2. (d) 3. (0 4. (b) 5. (o)
6. (d) 7. (b) 8. (a) 9. (b) 10. (o)
B 1. Spot Healing Brush Tool 2. Smudge Tool 3. video conferencing
4. Social networking 5. print() 6. if 7. brain 8. artificial intelligence
9. Integrated Circuit 10. Dantell

]
\
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Section B

Layers are transparent sheets containing objects which are stacked on top of each other
so that individual properties of an object can be edited without affecting other objects.

Phreaking is a cyber crime committed against telephone companies by using computers.
The input() function is used to display the output on the screen.

The assertion that machines that do so strong Al are actually thinking (not just simulating
thinking) is called the strong Al hypothesis.

The branch of mechanical engineering, electrical engineering and computer science that
deals with the design, construction, operation and application of robots, as well as computer
systems for their control, sensory feedback and information processing is called Robotics.

To use Clone Stamp Tool:

Step 1 Open the image and then click on Clone Stamp Tool from the Toolbar.
Step 2 Select the brush size and hardness from Options bar.

Step 3 Press and hold the Alt key and click on the image to be cloned.

Step 4 Click and drag the mouse at the place where the clone is to be created.

Step 5 When you drag the mouse pointer, you will see a plus sign on the original image
and a small circle on the cloned image.

Step 6 Release the mouse button when clone completed.

Computer hacking is the practice of modifying computer hardware and software to
accomplish a goal outside of the creator’s original purpose and cracking is the same practice
though with criminal intention.

The if statement allows you to test a condition before executing the statements and the
if....else statement is used to execute either of the block of statements from if or else
statements.

Artificial Intelligence is being successfully implemented in:

(i) Robotics Vehicles: Driverless robotic cars outfitted with cameras, radar and laser
range finders to sense the environment and software to command & control steering,
brakes and accelerator and also obey the traffic rules.

(i) Speech recognition: Conversation guided by an automated speech recognition and
dialog management system.

(i) Game playing: IBM's Deep Blue became the first computer program to defeat a
world champion in a chess match.

(iv) Autonomous planning and scheduling: NASA's Remote Agent program became
the first on board autonomous planning program to control the scheduling of
operations for a spacecraft.

5. Robotics gained a vital place in the environmental sector. A robot developed in England

can attack insects like some omnivorous plants. Also a London aquarium exhibits a robot
that has been inspired by a fish.

circumference = float(input("Enter circumference of a circle: *))
radius = circumference/(2*3.14)
print(“Radius of circle is:", radius)

\
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PRACTICE WORKSHEET

1. Computer Networking

A. Tick (v) the correct option.

1. The computer which performs a specific task is called a server.
a. Dedicated b. Database c. Network d. Web
2. The total diameter of LAN is not more than .
a. 100 m b. 500 m c. 5km d. 500 km
3. Bluetooth 5.0 technology provides data transfer speed upto .
a. 1Kbps b. 1 Mbps c. 2 Mbps d. 4 Tbps
4. is a networking device that can convert the digital data into analog signal
and vice-versa.
a. Hub b. Router c. Modem d. NIC
5. is a protocol used to send e-mail messages over the internet.
a. HTTPS b. TCP/IP c. POP3 d. SMTP

B. Identify the type of topology and define it.
1. 2. 3.

@m‘ Ty e [remr /V\,ﬁm iy
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Note: More Worksheets are available online. Visit www.thetouchpad.com
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2. Introduction/to/MS/ Access 2010

A. Tick (v) the correct option.

1.

2.

3.

4.

rule defines a Relational Database Management System.

a. Mark’s b. Codd's

c. Bill's d. Babbage's
The Close Database option is present under tab.
a. File b. Home

c. Create d. Table

The default data type for Primary Key is

a. Text b. Number

¢. Auto Number d. OLE

The process of displaying the information from the table is called
a. Query b. Form

c. Report d. Wizard

B. WhoamI?

1.
2.

3.
4.
5.

C. State whether the given statements are True or False. Correct the false statements.
1

viAcwnN

I am a button that helps in navigating the records.

I am the place where all tables, queries and forms opened in MS Access 2010
are present in the form of tabs.

I display the names of the database objects that are open.
I am the area where records are added to various fields.
[ am the topmost bar in MS Access 2010 window.

MS Access is a powerful and easy to use Relational Database Management
System.

Templates are the in-built format of queries that focus on the specific task.
The maximum size of the Text data type is 2500 characters.

Field name can begin with an underscore.

Query is used to sort the data in ascending or descending order.

D. Answer these questions.

1.

i wnN

Name the different types of databases.

Define hyperlink data type in Access.

Differentiate between Datasheet View and Design View.

What are the steps to create a database using Templates?

What are the advantages of the Database Management System?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

3., Moreion MS Access 2010

A.

Tick (v) the correct option.

1.

command is used to edit title of the form.
a. Header b. Top
c. Title d. Design

query uses row headings and column headings so that you can see your data
in terms of two categories at once.

a. Parameter b. Action
c. Crosstab d. SQL

3. The tab that does not appear on the Report window is
a. Arrange b. Format
c. Page Setup d. Module

4,

The feature in MS Access which allows us to retrieve data from a table is called

a. Primary key b. Foreign key
c. Select query d. None of these

Identify the icon and state its use.

3. 'EK%EI 4. @ 5.

D |

State whether the given statements are True or False. Correct the false statements.

1.

A W

Navigation bar is at the top of the Form window.

MS Access allows you to create or build a query and save it in the database.
A Primary Key is a column in one table that must match the Foreign Key.
Or parameter is used to set multiple conditions in a query.

Design View is used to change the appearance of the form.

D. Answer these questions.

1.

vk W

Why do we need a form in MS Access?

Write the steps to print a report.

Name the various parameters of the design grid of the Query window.
What are the various types of forms in MS Access?

What is a Primary Key? Why is it necessary to have a primary key in a table?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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4. Listsiand Tables in HTML

A. Tick (v) the correct option.
1. Type and Start are attributes of tag.
a. <OL> b. <LI> c. <UL> d. <A>
2. is not an attribute of <TD> tag.
a. Align b. Width c. Rowspan d. Cellpadding
3. A represents data in the form of rows and columns.
a. Frame b. Table c. List d. Link
4. The attribute of the <TABLE> tag that gives the space between the adjacent cells is
a. Cellspacing b. Cellpadding c. Rowspan d. Colspan
B. Find the errors in the following code for creating a definition list in HTML.
<BODY>
<B> Example of Definition List </B> <HR> E
<DL> A
<DD> Beverages </DT> %‘
<DT> Hot and Cold Drinks </DD> m
<DT> Cappucino </DT> S
<DD> Hot Drinks </DD> :OU
</DL> a
</HR> %
</BODY> ﬂ
C. State whether the given statements are True or False. Correct the false statements.

1. There are three types of lists that can be created in HTML.

2. The frames tag is given sides value when the border is to be displayed at
both left and right sides of the table.

3. The WIDTH attribute is used when a single cell is extended to more than a
single column.

4. The <TR> tag is used to create cells in the table.

D. Answer these questions.

1. Whenis an unordered list created?

2. What is the use of BORDERCOLOR attribute?
3. Whatis VALIGN?

4. What is a description list?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

5. Moreon' HTML

A. Tick (v)) the correct option.

1. Behaviour=" " will make the object move from the start to the end and then
bounce back from the end to the start.
a. SLIDE b. SCROLL
c. ALTERNATE d. MARQUEE
2. Hyperlink text is generally seen in colour.
a. Blue b. Green
c. Red d. Grey
3. The tag divides the window into horizontal frames by using ROWS attribute.
a. <FRAME> b. <FRAMESET>
c. <A> d. <TABLE>
4. attribute is not used with the <IMG> tag.
a. SRC b. FRAME
c. HEIGHT d. All of these
B. Match the attributes in Column I with the tag they are used with in Column IL
Column Column II
1. ALT a. <A>
2. BEHAVIOUR b. <FRAMESET>
3. HREF c¢. <MARQUEE>
4. FRAME d. <IMG>
5. COLS e. <NORESIZE>
C. State whether the given statements are True or False. Correct the false statements.
1. The <MARQUEE> tag is an empty tag.
2. VLINK attribute is used to define the colour of the link that the user has
already visited.
3. Ininternal linking, the hyperlink points to a specific section within the same
document or web page.
4. PNG image file format stands for Portable Ink Group.
5. The <A> tag is used to link two web pages.
D. Answer these questions.
1. What do ALINK and VLINK stand for?
2. Which attribute of the <FRAMESET> tag is used to divide the window horizontally?
3. How is a hyperlink to an e-mail address created?
4. Whatis the use of SCROLLAMOUNT attribute? What is the range of values that this attribute
can take?
5. What are the various attributes used with <IMG> tag?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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6. Moreion/Photoshop/CS6

A. Tick (v) the correct option.

1.

The shortcut key to select Spot Healing Brush Tool is

a. S b. H
c B d J
key is pressed while selecting the image to be cloned.
a. Alt b. Ctrl
c. Shift d. Del
tool is used to duplicate part of an image.
a. Stamp Tool b. Spot Healing Brush Tool
c. Clone Stamp Tool d. Smudge Tool

tool requires a source point to repair the image.

a. Healing Brush b. Spot Healing Brush
c. Stamp d. None of these

key combination is pressed to add a new layer in Photoshop.
a. Alt+N b. Shift+N
c. Ctrl+N d. Ctrl+Shift+N

B. Name the tool and state its use.

2 B4 A 4.“

C. State whether the given statements are True or False. Correct the false statements.

1.

Retouching tools are used to add or remove features to the image.
Clone Stamp Tool is hidden under Pattern Stamp Tool.

2
3. The Create a New Layer button is present at the bottom of the Options Bar.
4.
5

Crop Tool is used to blur the background of the selected image.
Ctrl + D is used to deselect the selection.

D. Answer these questions.

1

ik wnN

State the use of correction tools in Photoshop CS6.

What is the difference between Spot Healing Brush Tool and Healing Brush Tool?
What are the steps to use Clone Stamp tool?

Write the steps to use Smudge tool.

How are layers useful in Photoshop?

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

7. Internet/Services/and Cyber/Crime

A. Tick (v)) the correct option.
1. The first VoIP service was developed in .
a. 1973 b. 1978

c. 1983 d. 1988
2. is a platform where people with common interests or activities can connect
with each other.
a. Chatting b. Social Networking
c. Video Confferencing d. Blogging
3. The keeps a check on comments of participants, decides when to stop

discussion as well as approving the comments or articles of participants before they are
posted on the newsgroup page.

a. Blogger b. Blog Admin
c. News Admin d. User
4. is not a cloud storage service.
a. Google Drive b. SkyDrive
c. Dropbox d. Skype

B. Match the websites in Column I to the primary service offered by them from Column IL.

Columnl ColumnII

1. www.skype.com a. E-mail

2. www.gmail.com b. Social Networking
3. www.facebook.com c. Blogging

4. www.123greetings.com d. VoIP

5. www.blogger.com e. E-greetings

C. State whether the given statements are True or False. Correct the false statements.

1. Internet is the most popular means of communication today.

2. E-mail can be sent to many people simultaneously.

3. Chatting is a technology that gives calling facility over the Internet.

4. The deaf, mute and hard of hearing people can communicate with each
other using sign language on video conference.

5. Chats are described as diary of events.

D. Answer these questions.

What is hacking?

Discuss blogs in detail.

Write a short note on chatting.

State two advantages and two disadvantages of VoIP service.
Define the types of cyber crimes.

vk whh e

Note: More Worksheets are available online. Visit www.thetouchpad.com
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8. (Control Structures/in/Python

A. Tick (v) the correct option.

1. The function automatically converts the provided items into string even if
we provide a numeric value or an expression.
a. input() b. if() c. exit d. print()
2. The statement is the most basic conditional statement in Python.
a. if..then b. if c. if..else d. if...elif...else
3. Intheif...elif...else structure, there can be elif statement(s) and
else statement(s).
a. One, One b. One, Any number
c.  Any number, One d. Any number, Any number
4. statement forces the next iteration of the loop to take place.
a. continue b. break c. if..else d. if...elif...else

B. Find and correct the errors, if any, in these Python commands.
input(int("Enter your age”))

print(“Age is" : x)

marks=int(input(Enter marks scored in maths:))

ifx%2=0:

input(“Thank You!")

vihAwnN e

C. State whether the given statements are True or False. Correct the false statements.

1. Python is an object-oriented programming language.

2. The statement which is outside the if...else blocks is executed irrespective
of the condition being evaluated true or false.

3. The while loop is more commonly used as compared to for loop in Python.

4. The input() function can be used to display the output on the screen in
different formats.

5. The break statement allows you to break out of a loop in a Python program.

D. Answer these questions.

1. State the use of if...elif...else statement.

Why do we use conditional statements in Python?

Explain the working of the ‘for’ loop with an example.

Write a note on Jump statements.

Write a program to take input of 10 numbers from the user. The odd numbers need to be
added and even numbers need to be multiplied. Both sum and product calculated need
to be displayed in separate lines.

vk wnN

Note: More Worksheets are available online. Visit www.thetouchpad.com
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PRACTICE WORKSHEET

9., /Artificial Intelligence

A. Tick (v)) the correct option.

1 was used for automated logistics planning and scheduling for transportation
in war.
a. DART b. NASA
c. IBM d. None of these
2. The earliest successful Artificial Intelligence program was written in
a. 1921 b. 1931
c. 1941 d. 1951
3. is called the Father of Artificial Intelligence.
a. Thomas Knoll b. Charles Babbage
c. Alan Turing d. Ada Lovelace

4. The assertion that machines could act as if they were intelligent is called
Al Hypothesis.

a. Weak b. Strong
c. Bothaandb d. None of these

B. Expand the following.
1. IBM
2. NASA
3. DART
4
5

. Al
. IC

C. State whether the given statements are True or False. Correct the false statements.
1. Human brain has the ability for reasoning, problem solving and learning.

Sophia is a robot that interacts socially.

The concept of Al was first propounded in 1980.

Deep learning is a subset of Al that includes statistical techniques.

Deep Blue became the first computer program to defeat a world champion
in a wrestling match.

vk W

D. Answer these questions.

What is the use of machine vision?

Define Artificial Intelligence.

What can Artificial Intelligence do today?

What will be the ethical implication of intelligent machines?

State some fields where Artificial Intelligence is being successfully implemented.

v wNh e

Note: More Worksheets are available online. Visit www.thetouchpad.com
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10.

Robotics

A. Tick (v) the correct option.

1

2.

3.

4,

5.

The term mechatronics was coined by

a. Karel Kapek b. Isaac Asimov c. Alan Turing d. Tetsuro Mori

A human like machine that can do automated tasks is called a

a. Transformer b. Mechatronic

¢. Robot d. Emotion sensor

Robots are classified into types.

a. two b. three c. four d. five

The term robot was coined in .
a. 1900 b. 1920 c. 1940 d. 1947

The word means forced labour.
a. robot b. robotic c. robota d. reboot

B. Match the columns.

C. State whether the given statements are True or False. Correct the false statements.

1.

2
3.
4.
5

vk woin e

Column Column II

Robot a. Mount Spurr

Dante II b. Linux

Sophia ¢. Rossum'’s Universal Play
Android d. Unmanned Surgery
Mechatronics e. Humanoid

Instrumental surgeries are conducted without hurting a real person.

. A robot developed in America can attack insects.

Autonomous robots are controlled by electronic circuits.
Android also refers to a mobile operating system.
Robotics gained a vital place in the environmental sector.

D. Answer these questions.

1.

vk W

Define robotics.

What is android?

What do you understand by mechatronics?

How are robots used in the field of surgery?
Discuss the role of robots during natural calamities.

Note: More Worksheets are available online. Visit www.thetouchpad.com
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Goal Setting

S. No.

Name of learner

Weaknesses

Note: This is just a format for reference.

\ l\ ]
$146)
L1

“Motivation is what gets you started. Habit is what keeps you going.



for My Learners

Strengths

Remedial Plans

“When we heal the earth, we heal ourselves.”

§ “ /~
475
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Capture your Moments...

(Happy Classroom Moments...

(Challenging Classroom Moments...

“By failing to prepare, you are preparing to fail”
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